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Introduction
This manual describes how to connect the Display and the External Device (target PLC).

In this manual, the connection procedure will be described by following the below sections:

• The below Displays are no longer sold nor maintained by Pro-face. To reduce 
unplanned downtime due to aged hardware and to maximize your cyber security 
environment we recommend replacing your devices with a new, successor model.
For details, please visit our homepage for "Recommended Substitution".
Discontinued from GP-Pro EX 5.00 onwards: GP3000 Series, LT3000 Series, 
ST3000 Series, GP-4100 Series (Monochrome model), PL Series, PS3000/4000 
Series, PE4000 Series.

• For details on the Displays supported by the driver, please check the "Connectable 
Devices" on our website.
http://www.pro-face.com/trans/en/manual/1064.html

1 System Configuration
This section shows the types of External 
Devices which can be connected and SIO 
type.

"1 System Configuration" (page 3)

2 Selection of External Device
Select a model (series) of the External 
Device to be connected and connection 
method.

"2 Selection of External Device" (page 11)

3 Example of Communication Settings
This section shows setting examples for 
communicating between the Display and 
the External Device.

"3 Example of Communication Setting" 
(page 12)

4 Setup Items
This section describes communication 
setup items on the Display.
Set communication settings of the Display 
with GP-Pro Ex or in offline mode.

"4 Setup Items" (page 60)

5 Cable Diagram
This section shows cables and adapters 
for connecting the Display and the 
External Device.

"5 Cable Diagram" (page 68)

Operation

http://www.pro-face.com/trans/en/manual/1064.html
http://www.pro-face.com/trans/en/manual/1064.html
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1 System Configuration

The system configuration in the case when the External Device and the Display are connected is shown.

1.1 Schneider Electric SA External Device.

Series CPU Link I/F
SIO 
Type

Setting Example Cable Diagram

Micro

TSX 37 05 028DR1
TSX 37 08 056DR1
TSX 37 10 128DT1
TSX 37 10 128DR1
TSX 37 10 128DTK1
TSX 37 10 164DTK1
TSX 37 10 028AR1
TSX 37 10 028DR1

TER port on CPU RS232C Setting Example 1 
(page 12)

Cable Diagram 2 
(page 81)

Accessory box
TSX SCA 50

RS485
 (2wire)

Setting Example 3 
(page 16)

Cable Diagram 3 
(page 82)

TSX 37 21 101
TSX 37 22 101
TSX 37 21 001
TSX 37 22 001

TER port on CPU RS232C Setting Example 1 
(page 12)

Cable Diagram 2 
(page 81)

Accessory box
TSX SCA 50

RS485
 (2wire)

Setting Example 3 
(page 16)

Cable Diagram 3 
(page 82)

PCMCIA card for RS232C
TSX SCP 111 RS232C Setting Example 2 

(page 14)
Cable Diagram 4 
(page 96)

PCMCIA card for RS485
TSX SCP 114

RS485
 (2wire)

Setting Example 3 
(page 16)

Cable Diagram 5 
(page 99)

Premium

TSX P57 103M
TSX P57 153M
TSX P57 203M
TSX P57 253M
TSX P57 303M
TSX P57 353M
TSX P57 453M

PCMCIA card for RS232C
TSX SCP 111 RS232C Setting Example 4 

(page 18)
Cable Diagram 4 
(page 96)

PCMCIA card for RS485
TSX SCP 114

RS485
 (2wire)

Setting Example 5 
(page 20)

Cable Diagram 5 
(page 99)

Twido

TWD LCAA 10DRF
TWD LCAA 16DRF
TWD LCAA 24DRF
TWD LMDA 20DTK
TWD LMDA 
20DUK
TWD LMDA 20DRT
TWD LMDA 40DTK
TWD LMDA 
40DUK

Programming port on CPU RS232C Setting Example 6 
(page 22)

Cable Diagram 2 
(page 81)

TWD NAC 485T RS485
 (2wire)

Setting Example 7 
(page 24)

Cable Diagram 1 
(page 68)

Quantum

140 CPU 113 02
140 CPU 113 03
140 CPU 434 12A
140 CPU 534 14A

Modbus port on CPU RS232C Setting Example 8 
(page 26)

Cable Diagram 6 
(page 108)
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Momentum

171 CCS 700 00
171 CCS 700 10
171 CCS 760 00
171 CCC 760 10

Modbus port 1 on CPU RS232C Setting Example 9 
(page 28)

Cable Diagram 7 
(page 110)

171 CCS 780 00
171 CCC 780 10

Modbus port 1 on CPU RS232C Setting Example 9 
(page 28)

Cable Diagram 7 
(page 110)

Modbus port 2 on CPU RS485
 (4wire)

Setting Example 
10 (page 30)

Cable Diagram 8 
(page 112)

171 CCC 980 20
171 CCC 980 30 Modbus port 2 on CPU RS485

 (4wire)
Setting Example 
10 (page 30)

Cable Diagram 8 
(page 112)

M221

TM221C16R
TM221C16T
TM221C16U
TM221C24R
TM221C24T
TM221C24U
TM221C40R
TM221C40T
TM221C40U
TM221CE16R
TM221CE16T
TM221CE16U
TM221CE24R
TM221CE24T
TM221CE24U
TM221CE40R
TM221CE40T
TM221CE40U

Serial line 1 on CPU

RS232C Setting Example 
15 (page 48)

Cable Diagram 
13 (page 142)

RS485
 (2wire)

Setting Example 
16 (page 51)

Cable Diagram 
14 (page 144)

Serial line 2 on the 
Cartridges TMC2SL1 or 
TMC2CONV01

RS232C Setting Example 
18 (page 57)

Cable Diagram 
16 (page 170)

RS485
 (2wire)

Setting Example 
17 (page 54)

Cable Diagram 
17 (page 172)

TM221M16R
TM221M16RG
TM221M16T
TM221M16TG
TM221M32TK

Serial line 1 on CPU
RS232C Setting Example 

15 (page 48)
Cable Diagram 
13 (page 142)

RS485
 (2wire)

Setting Example 
16 (page 51)

Cable Diagram 
14 (page 144)

Serial line 2 on CPU RS485
 (2wire)

Setting Example 
17 (page 54)

Cable Diagram 
15 (page 157)

TM221ME16R
TM221ME16RG
TM221ME16T
TM221ME16TG
TM221ME32TK

Serial line 1 on CPU

RS-
232C

Setting Example 
15 (page 48)

Cable Diagram 
13 (page 142)

RS485
 (2wire)

Setting Example 
16 (page 51)

Cable Diagram 
14 (page 144)

Series CPU Link I/F
SIO 
Type

Setting Example Cable Diagram
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 Connection Configuration

Micro Series

• 1:1 Connection

Premium Series

• 1:1 Connection

Twido Series

• 1:1 Connection

• 1:n Connection
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Quantum Series

• 1:1 Connection

Momentum Series

• 1:1 Connection

M221 Series

• 1:1 Connection

• 1:n Connection

Serial line 1 on CPU
or

Serial line 2 on CPU

Max 16 units

Serial line 1 on CPU
or

Serial line 2 on CPU
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1.2 Yokogawa Electric Corporation External Devices.

 Connection Configuration

FCN/FCJ Series

• 1:1 Connection

• 1:n Connection

Series CPU Link I/F
SIO 
Type

Setting Example Cable Diagram

FCN NFCP100-S00

Serial port on CPU RS232C Setting Example 
11 (page 32)

Cable Diagram 9 
(page 117)

NFLR111-S00 RS232C Setting Example 
12 (page 36)

Cable Diagram 
10 (page 119)

NFLR121-S00

RS485
(4 wire)

Setting Example 
13 (page 40)

Cable Diagram 
11 (page 121)

RS485
(2 wire)

Setting Example 
14 (page 44)

Cable Diagram 
12 (page 129)

FCJ NFJT100-S100 Serial port on CONTROL 
UNIT RS232C Setting Example 

11 (page 32)
Cable Diagram 9 
(page 117)
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 IPC COM Port
When connecting IPC with an External Device, the COM port used depends on the series and SIO type. Please 

refer to the IPC manual for details.

Usable port

Series
Usable Port

RS-232C RS-422/485(4 wire) RS-422/485(2 wire)

PS-2000B COM1*1 , COM2, 
COM3*1, COM4

*1 The RI/5V can be switched. Use the IPC’s switch to change if necessary.

- -

PS-3450A, PS-3451A,
PS3000-BA, PS3001-BD COM1, COM2*1*2 COM2*1*2 COM2*1*2

PS-3650A (T41 model),
PS-3651A (T41 model) COM1*1 - -

PS-3650A (T42 model),
PS-3651A (T42 model) COM1*1*2, COM2 COM1*1*2 COM1*1*2

PS-3700A (Pentium®4-M)
PS-3710A

COM1*1, COM2*1, 
COM3*2 , COM4

*2 Set up the SIO type with the DIP Switch. Please set up as follows according to SIO type to be used.

COM3*2 COM3*2

PS-3711A COM1*1, COM2*2 COM2*2 COM2*2

PS4000*3 COM1, COM2 - -

PL3000 COM1*1*2, COM2*1, 
COM3, COM4 COM1*1*2 COM1*1*2

PE-4000B Atom N270 COM1, COM2 - -

PE-4000B Atom N2600 COM1, COM2 COM3*4 , COM4*4, 
COM5*4, COM6*4

COM3*4, COM4*4, 
COM5*4, COM6*4

PS5000 (Slim Panel Type 
Core i3 Model) *5 *6 COM1, COM2*4 COM2*4 COM2*4

PS5000 (Slim Panel Type 
Atom Model) 
*5 *6

COM1, COM2*7 COM2*7 COM2*7

PS5000 (Enclosed Panel 
Type)*8 COM1 - -

PS5000 (Modular Type 
PFXPU/PFXPP)*5 *6

PS5000 (Modular Type 
PFXPL2B5-6)

COM1*7 COM1*7 COM1*7

PS5000 (Modular Type 
PFXPL2B1-4) COM1, COM2*7 COM2*7 COM2*7

PS6000 (Advanced Box)
PS6000 (Standard Box) COM1*9 *10 *10

PS6000 (Basic Box) COM1*9 COM1*9 COM1*9
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DIP Switch settings (PL3000 / PS3000 Series)
RS-232C

*3 When making communication between an External Device and COM port on the Expansion slot,
only RS-232C is supported. However, ER (DTR/CTS) control cannot be executed because of the
specification of COM port.
For connection with External Device, use user-created cables and disable Pin Nos. 1, 4, 6 and 9.
Please refer to the IPC manual for details of pin layout.

*4 Set up the SIO type with the BIOS. Please refer to the IPC manual for details of BIOS.

*5 When setting up communication between an External Device and the RS-232C/422/485 interface
module, use the IPC (RS-232C) or PS5000 (RS-422/485) cable diagrams. However, when using
PFXZPBMPR42P2 in a RS-422/485 (4-wire) configuration with no flow control, connect 7.RTS+
and 8.CTS+, and connect 6.RTS- and 9.CTS-.
When using RS-422/485 communication with External Devices, you may need to reduce the
transmission speed and increase the TX Wait time.

*6 To use RS-422/485 communication on the RS-232C/422/485 interface module, the DIP Switch
setting is required. Please refer to "Knowledge Base" (FAQs) on the support site. (http://www.pro-
face.com/trans/en/manual/1001.html)

*7 Set up the SIO type with the DIP Switch. Please refer to the IPC manual for details of DIP Switch.
The BOX Atom has not a switch to set the RS-232C, RS-422/485 mode. Use the BIOS for the
setting.

*8 For the connection with the External Device, on the user-created cable read as if the connector on
the Display-side is a M12 A-coding 8 pin socket. The pin assignment is the same as described in
the cable diagram. For the M12 A-coding connector, use PFXZPSCNM122.

*9 In addition to COM1, you can also use the COM port on the optional interface.

*10 Install the optional interface in the expansion slot.

DIP Switch Setting Description

1 OFF*1

*1 When using PS-3450A, PS-3451A, PS3000-BA and PS3001-BD, turn ON the set value.

Reserved (always OFF)

2 OFF
SIO type: RS-232C

3 OFF

4 OFF Output mode of SD (TXD) data: Always output

5 OFF Terminal resistance (220)  insertion to SD (TXD): None

6 OFF Terminal resistance (220)  insertion to RD (RXD): None

7 OFF Short-circuit of SDA (TXA) and RDA (RXA): Not available

8 OFF Short-circuit of SDB (TXB) and RDB (RXB): Not available

9 OFF
RS (RTS) Auto control mode: Disabled

10 OFF

Settings FAQ ID

PFXZPBMPR42P2, RS422/485 change method FA263858

PFXZPBMPR42P2 termination resistor setting FA263974

PFXZPBMPR44P2, RS422/485 change method FA264087

PFXZPBMPR44P2 termination resistor setting FA264088
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RS-422/485 (4 wire)

RS-422/485 (2 wire)

DIP Switch Setting Description

1 OFF Reserved (always OFF)

2 ON
SIO type: RS-422/485

3 ON

4 OFF Output mode of SD (TXD) data: Always output

5 OFF Terminal resistance (220)  insertion to SD (TXD): None

6 OFF Terminal resistance (220)  insertion to RD (RXD): None

7 OFF Short-circuit of SDA (TXA) and RDA (RXA): Not available

8 OFF Short-circuit of SDB (TXB) and RDB (RXB): Not available

9 OFF
RS (RTS) Auto control mode: Disabled

10 OFF

DIP Switch Setting Description

1 OFF Reserved (always OFF)

2 ON
SIO type: RS-422/485

3 ON

4 OFF Output mode of SD (TXD) data: Always output

5 OFF Terminal resistance (220)  insertion to SD (TXD): None

6 OFF Terminal resistance (220)  insertion to RD (RXD): None

7 ON Short-circuit of SDA (TXA) and RDA (RXA): Available

8 ON Short-circuit of SDB (TXB) and RDB (RXB): Available

9 ON
RS (RTS) Auto control mode: Enabled

10 ON
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2 Selection of External Device

Select the External Device to be connected to the Display.

Setup Items Setup Description

Number of Devices/
PLCs Enter an integer from 1 to 4 to define the number of Devices/PLCs to connect to the display.

Manufacturer Select the manufacturer of the External Device to connect. Select "Schneider Electric SA".

Series

Select the External Device model (series) and the connection method. Select "MODBUS SIO 
Master".
In System configuration, make sure the External Device you are connecting is supported by 
"MODBUS SIO Master".

"1 System Configuration" (page 3)

Port Select the Display port to connect to the External Device.

Use System Area

Check this option to synchronize the system data area of the Display and the device (memory) 
of the External Device. When synchronized, you can use the External Device’s ladder program 
to switch the display or display the window on the Display.

Cf. GP-Pro EX Reference Manual "LS Area (Direct Access Method Area)"
This feature can also be set in GP-Pro EX or in the Display's offline mode.

Cf. GP-Pro EX Reference Manual "System Settings [Display Unit] - [System Area] 
Settings Guide"

Cf. Maintenance/Troubleshooting Guide "Main Unit - System Area Settings"
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3 Example of Communication Setting

Examples of communication settings of the Display and the External Device, recommended by Pro-face, are 

shown.

3.1 Setting Example 1

 Settings of GP-Pro EX

Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].
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Device Setting

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC] 

window, select the external device and click [Settings] . 

To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click [Add 

Device] to add another External Device.

 Settings of External Device
Use the ladder software "PL7 PRO" for communication settings.

Double-click "Hardware Configuration" from "Configuration" in "Application Browser" of "PL7 PRO". Next, 

double-click "Comm" in the "Configuration" dialog box. Perform the settings in the displayed dialog box.

Notes

• Please refer to the manual of the ladder software for more detail on other setting description.

Setup Items Setup Description

CHANNEL
CHANNEL 0

MODBUS/JBUS LINK MAST

Slave number 1

Transmission speed 9600bps

Delay between characters 5msec

Data RTU (8 bit)

Stop 1 bit

Parity Even

[Equipment Configuration] tab [Max Query] tab
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3.2 Setting Example 2

 Settings of GP-Pro EX

Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].
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Device Setting

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC] 

window, select the external device and click [Settings] . 

To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click [Add 

Device] to add another External Device.

 Settings of External Device
Use the ladder software "PL7 PRO" for communication settings.

Double-click "Hardware Configuration" from "Configuration" in "Application Browser" of "PL7 PRO". Next, 

double-click "Comm" in the "Configuration" dialog box. Perform the settings in the displayed dialog box.

Notes

Please refer to the manual of the ladder software for more detail on other setting description.

Setup Items Setup Description

CHANNEL

CHANNEL 1

TSX SCP 111 RS232 MP PCMCIA CARD

MODBUS/JBUS LINK MAST

Slave number 1

Type Slave

Transmission speed 9600bps

Delay between characters 4msec

Data RTU (8 bit)

Stop 1 bit

Parity Even

[Equipment Configuration] tab [Max Query] tab
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3.3 Setting Example 3

 Settings of GP-Pro EX

Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].
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Device Setting

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC] 

window, select the external device and click [Settings] . 

To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click [Add 

Device] to add another External Device.

 Settings of External Device
Use the ladder software "PL7 PRO" for communication settings.

Double-click "Hardware Configuration" from "Configuration" in "Application Browser" of "PL7 PRO". Next, 

double-click "Comm" in the "Configuration" dialog box. Perform the settings in the displayed dialog box.

Notes

Please refer to the manual of the ladder software for more detail on other setting description.

Setup Items Setup Description

CHANNEL

CHANNEL 1

TSX SCP 114 RS485 MP PCMCIA CARD

MODBUS/JBUS LINK MAST

Slave number 1

Type Slave

Transmission speed 9600bps

Delay between characters 4msec

Data RTU (8 bit)

Stop 1 bit

Parity Even

[Equipment Configuration] tab [Max Query] tab
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3.4 Setting Example 4

 Settings of GP-Pro EX

Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].
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Device Setting

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC] 

window, select the external device and click [Settings] . 

To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click [Add 

Device] to add another External Device.

 Settings of External Device
Use the ladder software "PL7 PRO" for communication settings.

Double-click "Hardware Configuration" from "Configuration" in "Application Browser" of "PL7 PRO". Next, 

double-click "Comm" in the "Configuration" dialog box. Perform the settings in the displayed dialog box.

Notes

• Please refer to the manual of the ladder software for more detail on other setting description.

Setup Items Setup Description

CHANNEL

CHANNEL 1

TSX SCP 111 RS232 MP PCMCIA CARD

MODBUS/JBUS LINK MAST

Type Slave

Slave number 1

Transmission speed 9600bps

Delay between characters 4msec

Data RTU (8 bit)

Stop 1 bit

Parity Even

[Equipment Configuration] tab [Max Query] tab
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3.5 Setting Example 5

 Settings of GP-Pro EX

Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].
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Device Setting

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC] 

window, select the external device and click [Settings] . 

To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click [Add 

Device] to add another External Device.

 Settings of External Device
Use the ladder software "PL7 PRO" for communication settings.

Double-click "Hardware Configuration" from "Configuration" in "Application Browser" of "PL7 PRO". Next, 

double-click "Comm" in the "Configuration" dialog box. Perform the settings in the displayed dialog box.

Notes

Please refer to the manual of the ladder software for more detail on other setting description.

Setup Items Setup Description

CHANNEL

CHANNEL 1

TSX SCP 114 RS485 MP PCMCIA CARD

MODBUS/JBUS LINK MAST

Type Slave

Slave number 1

Transmission speed 9600bps

Delay between characters 4msec

Data RTU (8 bit)

Stop 1 bit

Parity Even

[Equipment Configuration] tab [Max Query] tab
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3.6 Setting Example 6

 Settings of GP-Pro EX

Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].
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Device Setting

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC] 

window, select the external device and click [Settings] . 

To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click [Add 

Device] to add another External Device.

 Settings of External Device
Use the ladder software "TwidoSoft" for communication settings.

Select "Hardware" from "TWDLMDA40DUK" in "Application Browser" of "TwidoSoft", and right-click on 

"Port 1 : Remote Link, 1" to select "Edit Controller Comm Setup...".

Perform the settings in the "Controller Communication Setup" dialog box displayed next.

Notes

Please refer to the manual of the ladder software for more detail on other setting description.

Setup Items Setup Description

Protocol
Type Modbus

Address 1

Parameters

Baud Rate 19200

Data Bits 8

Parity None

Stop Bits 1

End of Frame 10

Response Timeout 10 x 100msec

Frame Timeout 4msec

[Equipment Configuration] tab [Max Query] tab
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3.7 Setting Example 7

 Settings of GP-Pro EX

Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].
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Device Setting

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC] 

window, select the external device and click [Settings] . 

To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click [Add 

Device] to add another External Device.

 Settings of External Device
Use the ladder software "TwidoSoft" for communication settings.

Right-click on "Hardware" from "TWDLMDA40DUK" in "Application Browser" of "TwidoSoft" to select "Add 

Option...". Right-click on "Port 2 : Modbus, 1" added to "Hardware" in "TWDLMDA40DUK" to select "Edit 

Controller Comm Setup...".

Perform the settings in the "Controller Communication Setup" dialog box displayed next.

Notes

Please refer to the manual of the ladder software for more detail on other setting description.

Setup Items Setup Description

Protocol
Type Modbus

Address 1

Parameters

Baud Rate 19200

Data Bits 8

Parity None

Stop Bits 1

End of Frame 10

Response Timeout 10 x 100msec

Frame Timeout 10msec

[Equipment Configuration] tab [Max Query] tab
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3.8 Setting Example 8

 Settings of GP-Pro EX

Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].
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Device Setting

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC] 

window, select the external device and click [Settings] . 

To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click [Add 

Device] to add another External Device.

 Settings of External Device
Use the ladder software "Concept" for communication settings.

After selecting the External Device in Quantum Series in "PLC Selection" of "Concept", select "Modbus Port 

Settings" and perform the settings in the "Modbus Port Settings" dialog box.

Notes

Please refer to the manual of the ladder software for more detail on other setting description.

Setup Items Setup Description

Baud 19200

Data Bits 8

Stop Bits 1

Parity Even

Delay(ms) 10

Address 1

Head slot 0

Mode RTU

Protocol RS232

[Equipment Configuration] tab [Max Query] tab
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3.9 Setting Example 9

 Settings of GP-Pro EX

Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].
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Device Setting

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC] 

window, select the external device and click [Settings] . 

To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click [Add 

Device] to add another External Device.

 Settings of External Device
Use the ladder software "Concept" for communication settings.

After selecting the External Device in Momentum Series in "PLC Selection" of "Concept", select "Modbus Port 

Settings" and perform the settings in the "Modbus Port Settings" dialog box.

Notes

Please refer to the manual of the ladder software for more detail on other setting description.

Setup Items Setup Description

Baud 19200

Data Bits 8

Stop Bits 1

Parity Even

Delay(ms) 10

Address 1

Head slot 0

Mode RTU

Protocol RS232

[Equipment Configuration] tab [Max Query] tab
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3.10 Setting Example 10

 Settings of GP-Pro EX

Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].
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Device Setting

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC] 

window, select the external device and click [Settings] . 

To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click [Add 

Device] to add another External Device.

 Settings of External Device
Use the ladder software "Concept" for communication settings.

After selecting the External Device in Momentum Series in "PLC Selection" of "Concept", select "Modbus Port 

Settings" and perform the settings in the "Modbus Port Settings" dialog box.

Notes

Please refer to the manual of the ladder software for more detail on other setting description.

Setup Items Setup Description

Baud 19200

Data Bits 8

Stop Bits 1

Parity Even

Delay(ms) 10

Address 1

Head slot 0

Mode RTU

Protocol RS485

[Equipment Configuration] tab [Max Query] tab
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3.11 Setting Example 11

 Settings of GP-Pro EX

Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].
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Device Setting

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC] 

window, select the external device and click [Settings] . 

To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click [Add 

Device] to add another External Device.

 Settings of External Device
Use the Web browser and ladder software (Logic Designer) for communication settings.

<Communication Settings for the Serial Port on CPU>
1 Set IP address of the External Device to "192.168.1.1".

2 Connect both the Ethernet ports between a PC and the External Device using the LAN cable. (Connect via HUB.)

3 Start up the Web browser.

4 Enter "http://192.168.1.1/mnt" in the address input box.

5 Enter [User Name] and [Password] in the displayed dialog box to login.

6 Click [Maintenance Menu] to display the [FCX Maintenance Menu] screen.

7 Click [Reboot] to display the [Reboot FCX] screen.

8 Check the [Reboot(Maintenance Mode)] option.

9 Click [OK] to display the [Reboot] screen.

10 Reboot the External Device. Confirm the reboot is complete.

11 Click [Maintenance Homepage] to display the [STARDOM FCX Maintenance Page] screen.

12 Click [OK] to display the [FCX Maintenance Menu] screen.

13 Click [Edit] to display the [Edit System Setting Files] screen.

• For more details on how to set IP address of the External Device, refer to the online help of the 
dedicated tool for the FCN/FCJ basic settings (Resource Configurator).

[Equipment Configuration] tab [Max Query] tab
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14 Check the [COM1 Port Setting File] option and click [OK].

15 Set each item as follows:

16 Click [OK] to display the [Edit System Setting Files(RESULT)] screen.

17 Click [Maintenance Menu] to display the [FCX Maintenance Menu] screen.

18 Click [Reboot] to display the [Reboot FCX] screen.

19 Check the [Reboot(Online Mode)] option and click [OK].

The External Device is rebooted.

<Control Logic Download Procedures>
1 Start up the ladder software.

2 Create the control logic in order to start the MODBUS communication (RTU mode) slave function. For the 

example of control logic, refer to "Control Logic Example".

"  Control Logic Example" (page 35)

3 Double-click ['COM1'] next to [PORT] to display the [Variable Properties] dialog box.

4 Enter the connecting port name in [Name], and click [OK].

5 Double-click [UNIT#1] next to [STATION] to display the [Variable Properties] dialog box.

6 Enter the connecting station name in [Name], and click [OK].

7 Select [Rebuild Project] from the [Build] menu.

8 Double-click [Target Setting] in the project tree window to display the [Target] dialog box.

9 Enter "192.168.1.1" in [Host Name/IP Address].

10 Click [OK].

11 Download the communication settings to the External Device.

12 Reboot the External Device.

Setup Items Setup Description

Baudrate 19200

DataBitLength 8

StopBitLength 1

Parity EVEN
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Control Logic Example

To connect the Display to the External Device, the control logic is required.

The control logic example is shown below.
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3.12 Setting Example 12

 Settings of GP-Pro EX

Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].
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Device Setting

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC] 

window, select the external device and click [Settings] . 

To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click [Add 

Device] to add another External Device.

 Settings of External Device
Use the dedicated tool for basic settings (Resource Configurator) and ladder software (Logic Designer) for 

communication settings.

<Communication Settings for the Communication Module>
1 Set IP address of the External Device to "192.168.1.1".

2 Start up the dedicated tool for the basic settings.

3 From the [File] menu, select [Connection] to display the [Connect] dialog box.

4 Enter "192.168.1.1" in [Host].

5 Enter [User Name] and [Password] to login.

6 Select the link I/F to use from the [Controller Configuration] tree view.

7 Enter the port name in [Port Name].

8 Select [Port1] from the link I/F to use the [Controller Configuration] tree view.

• For more details on how to set IP address of the External Device, refer to the online help of the 
dedicated tool for the FCN/FCJ basic settings.

[Equipment Configuration] tab [Max Query] tab
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9 Set specifications as follows:

10 Download the communication settings to the External Device.

11 Reboot the External Device.

<Control Logic Download Procedures>
1 Start up the ladder software.

2 Create the control logic in order to start the MODBUS communication (RTU mode) slave function. For the 

example of control logic, refer to "Control Logic Example".

"  Control Logic Example" (page 39)

3 Double-click ['COM1'] next to [PORT] to display the [Variable Properties] dialog box.

4 Enter the connecting port name in [Name], and click [OK].

5 Double-click [UNIT#1] next to [STATION] to display the [Variable Properties] dialog box.

6 Enter the connecting station name in [Name], and click [OK].

7 Select [Rebuild Project] from the [Build] menu.

8 Double-click [Target Setting] in the project tree window to display the [Target] dialog box.

9 Enter "192.168.1.1" in [Host Name/IP Address].

10 Click [OK].

11 Download the communication settings to the External Device.

12 Reboot the External Device.

Specifications Setting

Wiring Method -

Duplex Operation Full-duplex

Baud Rate 19200

Data Bits 8

Parity Setting EVEN

Stop Bits 1

Send Signal Check NONE

Receive Flow Control NONE

API Error Detection YES
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Control Logic Example

To connect the Display to the External Device, the control logic is required.

The control logic example is shown below.
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3.13 Setting Example 13

 Settings of GP-Pro EX

Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].
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Device Setting

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC] 

window, select the external device and click [Settings] . 

To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click [Add 

Device] to add another External Device.

 Settings of External Device
Use the dedicated tool for basic settings (Resource Configurator) and ladder software (Logic Designer) for 

communication settings.

<Communication Settings for the Communication Module>
1 Set IP address of the External Device to "192.168.1.1".

2 Start up the dedicated tool for the basic settings.

3 From the [File] menu, select [Connection] to display the [Connect] dialog box.

4 Enter "192.168.1.1" in [Host].

5 Enter [User Name] and [Password] to login.

6 Select the link I/F to use from the [Controller Configuration] tree view.

7 Enter the port name in [Port Name].

8 Select [Port1] from the link I/F to use the [Controller Configuration] tree view.

• For more details on how to set IP address of the External Device, refer to the online help of the 
dedicated tool for the FCN/FCJ basic settings.

[Equipment Configuration] tab [Max Query] tab
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9 Set specifications as follows:

10 Download the communication settings to the External Device.

11 Reboot the External Device.

<Control Logic Download Procedures>
1 Start up the ladder software.

2 Create the control logic in order to start the MODBUS communication (RTU mode) slave function. For the 

example of control logic, refer to "Control Logic Example".

"  Control Logic Example" (page 43)

3 Double-click ['COM1'] next to [PORT] to display the [Variable Properties] dialog box.

4 Enter the connecting port name in [Name], and click [OK].

5 Double-click [UNIT#1] next to [STATION] to display the [Variable Properties] dialog box.

6 Enter the connecting station name in [Name], and click [OK].

7 Select [Rebuild Project] from the [Build] menu.

8 Double-click [Target Setting] in the project tree window to display the [Target] dialog box.

9 Enter "192.168.1.1" in [Host Name/IP Address].

10 Click [OK].

11 Download the communication settings to the External Device.

12 Reboot the External Device.

Specifications Setting

Wiring Method -

Duplex Operation Full-duplex

Baud Rate 19200

Data Bits 8

Parity Setting EVEN

Stop Bits 1

Send Signal Check NONE

Receive Flow Control NONE

API Error Detection YES
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Control Logic Example

To connect the Display to the External Device, the control logic is required.

The control logic example is shown below.
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3.14 Setting Example 14

 Settings of GP-Pro EX

Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].
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Device Setting

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC] 

window, select the external device and click [Settings] . 

To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click [Add 

Device] to add another External Device.

 Settings of External Device
Use the dedicated tool for basic settings (Resource Configurator) and ladder software (Logic Designer) for 

communication settings.

<Communication Settings for the Communication Module>
1 Set IP address of the External Device to "192.168.1.1".

2 Start up the dedicated tool for the basic settings.

3 From the [File] menu, select [Connection] to display the [Connect] dialog box.

4 Enter "192.168.1.1" in [Host].

5 Enter [User Name] and [Password] to login.

6 Select the link I/F to use from the [Controller Configuration] tree view.

7 Enter the port name in [Port Name].

8 Select [Port1] from the link I/F to use the [Controller Configuration] tree view.

• For more details on how to set IP address of the External Device, refer to the online help of the 
dedicated tool for the FCN/FCJ basic settings.

[Equipment Configuration] tab [Max Query] tab
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9 Set specifications as follows:

10 Download the communication settings to the External Device.

11 Reboot the External Device.

<Control Logic Download Procedures>
1 Start up the ladder software.

2 Create the control logic in order to start the MODBUS communication (RTU mode) slave function. For the 

example of control logic, refer to "Control Logic Example".

"  Control Logic Example" (page 47)

3 Double-click ['COM1'] next to [PORT] to display the [Variable Properties] dialog box.

4 Enter the connecting port name in [Name], and click [OK].

5 Double-click [UNIT#1] next to [STATION] to display the [Variable Properties] dialog box.

6 Enter the connecting station name in [Name], and click [OK].

7 Select [Rebuild Project] from the [Build] menu.

8 Double-click [Target Setting] in the project tree window to display the [Target] dialog box.

9 Enter "192.168.1.1" in [Host Name/IP Address].

10 Click [OK].

11 Download the communication settings to the External Device.

12 Reboot the External Device.

Specifications Setting

Wiring Method -

Duplex Operation Full-duplex

Baud Rate 19200

Data Bits 8

Parity Setting EVEN

Stop Bits 1

Send Signal Check NONE

Receive Flow Control NONE

API Error Detection YES
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Control Logic Example

To connect the Display to the External Device, the control logic is required.

The control logic example is shown below.
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3.15 Setting Example 15

 Settings of GP-Pro EX

Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

• Set [Text Data Mode] to 2.
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Device Setting

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC] 

window, select the external device and click [Settings] . 

To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click [Add 

Device] to add another External Device.

 Settings of External Device
Use the ladder software "SoMachine Basic" for communication settings.

1 Start up the ladder software.

2 From the [Configuration] tab, select [SL1 (Serial line)].

3 Set [Serial line configuration] as follows.

Setup Items Settings

Protocol Modbus

Baud rate 19200

Parity Even

Data bits 8

Stop bits 1

Physical medium RS-232C
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4 From the [Configuration] tab, select [Modbus].

5 Set [Modbus] as follows.

6 Download the communication settings to the External Device.

Notes

Please refer to the manual of the ladder software for more detail on other setting description.

Setup Items Settings

Device None

Transmission mode RTU

Addressing Slave

Address 1

Response timeout (100 ms) 10

Time between frames (ms) 10
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3.16 Setting Example 16

 Settings of GP-Pro EX

Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

• Set [Text Data Mode] to 2.
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Device Setting

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC] 

window, select the external device and click [Settings] . 

To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click [Add 

Device] to add another External Device.

 Settings of External Device
Use the ladder software "SoMachine Basic" for communication settings.

1 Start up the ladder software.

2 From the [Configuration] tab, select [SL1 (Serial line)].

3 Set [Serial line configuration] as follows.

Setup Items Settings

Protocol Modbus

Baud rate 19200

Parity Even

Data bits 8

Stop bits 1

Physical medium RS-485
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4 From the [Configuration] tab, select [Modbus].

5 Set [Modbus] as follows.

6 Download the communication settings to the External Device.

Notes

Please refer to the manual of the ladder software for more detail on other setting description.

Setup Items Settings

Device None

Transmission mode RTU

Addressing Slave

Address 1

Response timeout (100 ms) 10

Time between frames (ms) 10
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3.17 Setting Example 17

 Settings of GP-Pro EX

Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

• Set [Text Data Mode] to 2.
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Device Setting

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC] 

window, select the external device and click [Settings] . 

To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click [Add 

Device] to add another External Device.

 Settings of External Device
Use the ladder software "SoMachine Basic" for communication settings.

1 Start up the ladder software.

2 From the [Configuration] tab, select [SL2 (Serial line)].

3 Set [Serial line configuration] as follows.

Setup Items Settings

Protocol Modbus

Baud rate 19200

Parity Even

Data bits 8

Stop bits 1

Physical medium RS-485
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4 From the [Configuration] tab, select [Modbus].

5 Set [Modbus] as follows.

6 Download the communication settings to the External Device.

Notes

Please refer to the manual of the ladder software for more detail on other setting description.

Setup Items Settings

Device None

Transmission mode RTU

Addressing Slave

Address 1

Response timeout (100 ms) 10

Time between frames (ms) 10
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3.18 Setting Example 18

 Settings of GP-Pro EX

Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

• Set [Text Data Mode] to 2.
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Device Setting

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC] 

window, select the external device and click [Settings] . 

To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click [Add 

Device] to add another External Device.

 Settings of External Device
Use the ladder software "SoMachine Basic" for communication settings.

1 Start up the ladder software.

2 From the [Configuration] tab, select [SL2 (Serial line)].

3 Set [Serial line configuration] as follows.

Setup Items Settings

Protocol Modbus

Baud rate 19200

Parity Even

Data bits 8

Stop bits 1

Physical medium RS-232C
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4 From the [Configuration] tab, select [Modbus].

5 Set [Modbus] as follows.

6 Download the communication settings to the External Device.

Notes

Please refer to the manual of the ladder software for more detail on other setting description.

Setup Items Settings

Device None

Transmission mode RTU

Addressing Slave

Address 1

Response timeout (100 ms) 10

Time between frames (ms) 10
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4 Setup Items

Set communication settings of the Display with GP-Pro EX or in offline mode of the Display.

The setting of each parameter must be identical to that of External Device.

"3 Example of Communication Setting" (page 12)

4.1 Setup Items in GP-Pro EX

 Communication Settings
To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC]. 

Setup Items Setup Description

SIO Type Select the SIO type to communicate with the External Device.

Speed Select speed between the External Device and the Display.

Data Length Select data length.

Parity Select how to check parity.

Stop Bit Select stop bit length.

Flow Control Select the communication control method to prevent overflow of transmission and 
reception data.

Timeout Use an integer from 1 to 127 to enter the time (s) for which the Display waits for the 
response from the External Device.

Retry In case of no response from the External Device, use an integer from 0 to 255 to enter how 
many times the Display retransmits the command.



MODBUS SIO Master Driver

GP-Pro EX Device/PLC Connection Manual 61

Wait To Send

Use an integer from 0 to 255 to enter standby time (ms) for the Display from receiving 
packets to transmitting next commands.
When the check box of the default value is checked, the Wait To Send value automatically 
changes in the formula below by changing each value for Speed/Data Length/Parity/Stop 
Bit.

Wait To Send (ms) =

Value for the parity setting is shown below.
 No Parity = 0
 Parity Even = 1
 Parity Odd = 1

• After changing the Wait To Send value for the project, of which [Default Value] is 
checked, in the offline mode, the Wait To Send value will be recalculated when the 
project is received and communication settings are displayed.

RI/VCC
You can switch RI/VCC of the 9th pin when you select RS232C for SIO type.
It is necessary to change RI/5V by changeover switch of IPC when connect with IPC. 
Please refer to the manual of the IPC for more detail.

• Refer to the GP-Pro EX Reference Manual for Indirect Device.

Cf. GP-Pro EX Reference Manual "Changing the Device/PLC at Runtime (Indirect 
Device)"

Setup Items Setup Description

3500 x (1 + Data Length + Stop Bit + Parity)
Speed (bps)



MODBUS SIO Master Driver

GP-Pro EX Device/PLC Connection Manual 62

Device Setting

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC] 

window, select the external device and click [Settings] . 

To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click [Add 

Device] to add another External Device.

Setup Items Setup Description

Slave Equipment Address Use an integer from 1 to 247 to enter the slave equipment address of the 
External Device.

Bit manipulation (set / reset) to 
Holding Resister From "Clear" or "Do not clear", select treatment of the rest of the bits in the 

same word when the bit manipulation to Holding Register is performed.Rest of the bits in 
this word

IEC61131 Syntax Check this item when you use the IEC61131 syntax for variables. In case that 
you check on, select Address Mode, [0-based] or [1-based].

SoMachine Basic Syntax Check this item when you use SoMachine Basic syntax for variables. 
Use this setting with M221 series only.

Double Word word order Select the order of storing double word data from "Low word first" or "High 
word first".

Low Security Level Put a check when lowering the format check level.

[Equipment Configuration] tab
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Setup Items Setup Description

Coil Set the number of max data for device [coil] which can be read for one 
communication, using 16 to 2000 bits.

• When [Single Bit manipulation to Coil/Discrete Input] is checked, set the 
data maximum number from 1 to 2000.

Read

Coil Set the number of max data for device [coil] which can be written for one 
communication, using 1 to 800 bits.Write

Discrete Input Set the number of max data for device [discrete input] which can be read for 
one communication, using 16 to 2000 bits.

• When [Single Bit manipulation to Coil/Discrete Input] is checked, set the 
data maximum number from 1 to 2000.

Read

Input Register Set the number of max data for device [input register] which can be read for 
one communication, using 1 to 125 words.Read

Holding Register Set the number of max data for device [holding register] which can be read 
for one communication, using 1 to 125 words.Read

Holding Register Set the number of max data for device [holding register] which can be written 
for one communication, using 1 to 100 words.Write

Single Bit manipulation to Coil/
Discrete Input Put a check when writing in or reading out coil or discreet input in bits.

[Max Query] tab
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4.2 Setup Items in Offline Mode

Communication Settings

To display the setting screen, touch [Device/PLC Settings] from [Peripheral Settings] in offline mode. Touch the 

External Device you want to set from the displayed list.

• Refer to the Maintenance/Troubleshooting guide for information on how to enter offline mode or 
about the operation.

Cf. Maintenance/Troubleshooting Guide "Offline Mode"

• The number of the setup items to be displayed for 1 page in the offline mode depends on the 
Display in use. Please refer to the Reference manual for details.

Setup Items Setup Description

SIO Type

Select the SIO type to communicate with the External Device.

To make the communication settings correctly, confirm the serial interface specifications of 
Display unit for [SIO Type].
We cannot guarantee the operation if a communication type that the serial interface does 
not support is specified.
For details concerning the serial interface specifications, refer to the manual for Display 
unit.

Speed Select speed between the External Device and the Display.

Data Length Select data length.

Parity Select how to check parity.

Stop Bit Select stop bit length.

Flow Control Select the communication control method to prevent overflow of transmission and 
reception data.
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Device Setting

To display the setting screen, touch [Device/PLC Settings] from [Peripheral Settings]. Touch the External Device 

you want to set from the displayed list, and touch [Device].

(Page 1/2).

Timeout Use an integer from 1 to 127 to enter the time (s) for which the Display waits for the 
response from the External Device.

Retry In case of no response from the External Device, use an integer from 0 to 255 to enter how 
many times the Display retransmits the command.

Wait To Send Use an integer from 0 to 255 to enter standby time (ms) for the Display from receiving 
packets to transmitting next commands.

Setup Items Setup Description

Device/PLC Name Select the External Device for device setting. Device name is a title of External Device set 
with GP-Pro EX. (Initial value [PLC1])

Slave Address Use an integer from 1 to 247 to enter the slave equipment address of the External Device.

Bit manipulation to HR
From "Rest of bits in word are cleared" or "Rest of bits in word are not cleared", select 
treatment of the rest of the bits in the same word when the bit manipulation to Holding 
Register is performed. (Not available to set in offline mode.)

IEC61131 Syntax Displays the usage status of the currently set IEC61131 syntax in ON/OFF. (Not available 
to set in offline mode.)

SoMachine Syntax Displays the usage status of the currently set SoMachine Basic syntax in ON/OFF. (Not 
available to set in offline mode.)

Double Word word 
order

Displays the currently set order of storing double word data from "Low word first" or 
"High word first". (Not available to set in offline mode.)

Low Security Level When an format check level is lowered, ON/OFF is displayed. When the level is lowered, 
ON is displayed. (Not available to set in offline mode.)

Setup Items Setup Description
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(Page 2/2).

Setup Items Setup Description

Read Coil Displays the number of max data for device [coil] which can be read for one 
communication. (Not available to set in offline mode.)

Write Coil Displays the number of max data for device [coil] which can be written for one 
communication. (Not available to set in offline mode.)

Read Discrete Input Displays the number of max data for device [discrete input] which can be read for one 
communication. (Not available to set in offline mode.)

Read Input Register Set the number of max data for device [input register] which can be read for one 
communication, using 1 to 125 words.

Read Holding Register Set the number of max data for device [holding register] which can be read for one 
communication, using 1 to 125 words.

Write Holding Register Set the number of max data for device [holding register] which can be written for one 
communication, using 1 to 100 words.

Single Bit manipulation
ON/OFF display shows whether the coil or discreet input is written or read out in bits. If 
ON is displayed, writing or reading can be executed in bits. (Not available to set in offline 
mode.)
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Option

To display the setting screen, touch [Device/PLC Settings] from [Peripheral Settings]. Touch the External Device 

you want to set from the displayed list, and touch [Option].

Setup Items Setup Description

RI/VCC
You can switch RI/VCC of the 9th pin when you select RS232C for SIO type.
It is necessary to change RI/5V by changeover switch of IPC when connect with IPC. 
Please refer to the manual of the IPC for more detail.

• GP-4100 series, GP-4*01TM, GP-Rear Module, LT-4*01TM and LT-Rear Module do not 
have the [Option] setting in the offline mode.
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5 Cable Diagram

The following cable diagrams may be different from cable diagrams recommended by External Device 

Manufacturer.

Please be assured there is no operational problem in applying the cable diagram shown in this manual.

• The FG pin of the External Device body must be grounded according to your country’s applicable standard. 

Refer to your External Device manual for details.

• SG and FG are connected inside the Display. When connecting the External Device to SG, design your system 

to avoid short-circuit loops.

• Connect an isolation unit if the communication is not stable due to noise or other factors.

5.1 Cable Diagram 1

Display
(Connection Port)

Cable Notes

GP3000*1 (COM1)
AGP-3302B (COM2)
GP-4*01TM (COM1)
GP-Rear Module 
(COM1)
ST3000*2 (COM2)
LT3000 (COM1)

1A

COM Port Conversion Adapter by Pro-face
CA3-ADPCOM-01

+
Terminal Block Conversion Adapter by Pro-face

CA3-ADPTRM-01
+

User-created cable

The cable length 
must be 200m or 
less.

1B User-created cable

GP3000*3 (COM2)

1C

Online Adapter by Pro-face
CA4-ADPONL-01

+
Terminal Block Conversion Adapter by Pro-face

CA3-ADPTRM-01
+

User-created cable

The cable length 
must be 200m or 
less.

1D

Online Adapter by Pro-face
CA4-ADPONL-01

+
User-created cable

IPC*4 1E

COM Port Conversion Adapter by Pro-face
CA3-ADPCOM-01

+
Terminal Block Conversion Adapter by Pro-face

CA3-ADPTRM-01
+

User-created cable

The cable length 
must be 200m or 
less.

1F User-created cable

GP-4106  (COM1)
GP-4116T (COM1) 1G User-created cable

The cable length 
must be 200m or 
less.

GP-4107  (COM1)
GP-4*03T*5 (COM2)
GP-4203T (COM1) 1H User-created cable

The cable length 
must be 200m or 
less.
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GP4000*6 (COM2)
GP-4201T (COM1)
GP6000 (COM2)
SP5000*7 (COM1/2)
SP-5B00 (COM2)
ST6000*8 (COM2)
ST-6200 (COM1)
STM6000 (COM1)
STC6000 (COM1)
ET6000*9 (COM2)
PS6000 (Basic Box) 
(COM1/2)

1I

RS-422 Terminal Block Conversion Adapter by Pro-face
PFXZCBADTM1

*10

+
User-created cable

The cable length 
must be 200m or 
less.

1B User-created cable

LT-4*01TM (COM1)
LT-Rear Module 
(COM1) 1J

RJ45 RS-485 Cable (5m) by Pro-face
PFXZLMCBRJR81

The cable length 
must be 200m or 
less.

PE-4000B*11

PS5000*11

PS6000 (Optional 
Interface)*11

1K User-created cable
The cable length 
must be 200m or 
less.

*1  All GP3000 models except AGP-3302B

*2 Except AST-3211A and AST-3302B

*3 All GP3000 models except GP-3200 series and AGP-3302B

*4 Only the COM port which can communicate by RS-422/485 (2 wire) can be used. (Except PE-4000B, PS5000,
and PS6000)
 IPC COM Port (page 8)

*5 Except GP-4203T

*6 All GP4000 models except GP-4100 series, GP-4*01TM, GP-Rear Module, GP-4201T and GP-4*03T

*7 Except SP-5B00

*8 Except ST-6200

*9 Due to the COM port specifications, flow control is not possible. Omit wiring the control pins on the Display
side of the cable diagram.

*10 When using a Terminal Block Conversion Adapter (CA3-ADPTRM-01) instead of the RS-422 Terminal Block
Conversion Adapter, refer to Cable Diagram 1A.

*11 Only the COM port which can communicate by RS-422/485 (2 wire) can be used.
 IPC COM Port (page 8)

Display
(Connection Port)

Cable Notes
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1A)
• 1:1 Connection

• 1:n Connection

• The cable length must be 200m or less.

CA3-ADPTRM-01

CA3-ADPCOM-01 RDA

RDB

SDA

SDB

SG

FG

TRMRX

A

B

SG

Display

Display side

Signal name

Shield
External Device side

Terminal block

Signal name

User-created cable

RDA

RDB

SDA

SDB

SG

FG

TRMRX

A

B

SG

A

B

SG
Display CA3-ADPCOM-01

CA3-ADPTRM-01

Terminal block

Signal name

Shield
External Device side

Terminal block

Signal name
Shield

External Device side
Terminal block

Signal name

User-created cable



MODBUS SIO Master Driver

GP-Pro EX Device/PLC Connection Manual 71

1B)
• 1:1 Connection

• 1:n Connection

• The cable length must be 200m or less.

A

B

SG

2

3

7

5

4

SG

1

RDB

SDA

SDB

RDA

9

6

CSA

ERB

CSB

FG

ERA

8

Display
Termination
resistance

Display side
D-sub 9 pin (socket)

Pin Signal name

Shell

Signal name

External Device side
Terminal blockShield

A

B

SG

2

3

7

5

4

SG

1

RDB

SDA

SDB

RDA

9

6

CSA

ERB

CSB

FG

ERA

8

A

B

SGDisplay Termination
resistance

D-sub 9 pin (socket)

Pin Signal name

Shell

Shield
External Device side

Terminal block

Signal name

Shield
External Device side

Terminal block

Signal name

Display side
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1C)
• 1:1 Connection

• 1:n Connection

• The cable length must be 200m or less.

CA3-ADPTRM-01

CA4-ADPONL-01 RDA

RDB

SDA

SDB

SG
FG

TRMRX

A

B

SG

Display

Terminal block

Signal name

Shield
External Device side

Terminal block

Signal name

User-created cable

CA3-ADPTRM-01

RDA

RDB

SDA

SDB

SG

FG

TRMRX

A

B

SG

A

B

SG

CA4-ADPONL-01Display

Terminal block

Signal name

Shield
External Device side

Terminal block

Signal name

Shield
External Device side

Terminal block

Signal name

User-created cable
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1D)
• 1:1 Connection

• 1:n Connection

• The cable length must be 200m or less.

A

B

SG

2

7

3

8

9

1
5

SDB

RDA

RDB

SDA

TRMRX

SG

FG

TRMRX

CA4-ADPONL-01Display

D-sub 9 pin (plug)

Pin Signal name

Shell

Shield
External Device side

Terminal block

Signal name

User-created cable

A

B

SG

2

7

3

8

1

9

5

SDB

RDA

RDB

SDA

TRMRX

SG

FG

TRMRX

A

B

SG

CA4-ADPONL-01
Display

D-sub 9 pin (plug)

Pin

Shell

Shield
External Device side

Terminal block

Signal name Signal name

Shield
External Device side

Terminal block

Signal name

User-created cable
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1E)
• 1:1 Connection

• 1:n Connection

• The cable length must be 200m or less.

CA3-ADPTRM-01

CA3-ADPCOM-01 RDA

RDB

SDA

SDB

SG

FG

TRMRX

A

B

SG

Display

Display side

Signal name

Shield
External Device side

Terminal block

Signal name

User-created cable

RDA

RDB

SDA

SDB

SG

FG

TRMRX

A

B

SG

A

B

SG
Display CA3-ADPCOM-01

CA3-ADPTRM-01

Terminal block

Signal name

Shield
External Device side

Terminal block

Signal name
Shield

External Device side
Terminal block

Signal name

User-created cable
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1F)
• 1:1 Connection

• 1:n Connection

• The cable length must be 200m or less.

A

B

SG

Display

Termination
resistance

     Display side
D-sub 9 pin (socket)

Signal name

External Device side
Terminal blockShield

100Ω  1/2W

2

3

7

5

1
Pin

4

8

9

6

Shell

GND(SG)

DATA-

NC

NC

DATA+

Signal name

ERA

CSA

ERB

CSB

FG

100Ω  1/2W

A

B

SG

A

B

SG

Display

Termination
resistance

D-sub 9 pin (socket) Shield
External Device side

Terminal block

Signal name

Shield
External Device side

Terminal block

Signal name

2

3

7

5

1
Pin

4

8

9

6

Shell

GND(SG)

DATA-

NC

NC

DATA+

Signal name

ERA

CSA

ERB

CSB

FG

Display side
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1G)
• 1:1 Connection

• 1:n Connection

*1 The resistance in the Display is used as the termination resistance. Set the value of the DIP Switch on the 
rear of the Display as shown in the table below.  

DIP Switch No. Set Value

1 OFF

2 OFF

3 ON

4 ON

• The cable length must be 200m or less.

A

B

SG

SG

RDB

SDA

SDB

RDA

CSA

ERB

CSB

ERA

Display
Termination
resistance*1

Display side
Terminal block

Signal name Signal name

External Device side
Terminal blockShield

SG

A

B

SG

Shield
External Device side

Terminal block

Signal name

A

B

SG

SG

RDB

SDA

SDB

RDA

CSA

ERB

CSB

ERA

Display
Termination
resistance*1

Display side
Terminal block

Signal name Signal name

External Device side
Terminal blockShield

SG
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1H)
• 1:1 Connection

• 1:n Connection

• The 5V output (Pin #6) on the Display is the power for the Siemens AG’s PROFIBUS 
connector. Do not use it for other devices.

• In COM on the GP-4107, the SG and FG terminals are isolated.
• The cable length must be 200m or less.

A

B

SG

Display

Termination
resistance

Signal name

External Device side
Terminal blockShield

100Ω  1/2W

Pin Signal name

Display side
D-Sub 9pin (plug)

NC

NC

GND(SG)

RS(RTS)

5V

NC

NC

FG

LINE(+)

LINE(-)

3

8

1

2

5

4

6

7

9

Shell

100Ω  1/2W

A

B

SG

A

B

SG

Display

Termination
resistance

Shield
External Device side

Terminal block

Signal name

Shield
External Device side

Terminal block

Signal namePin Signal name

Display side
D-Sub 9pin (plug)

NC

NC

GND(SG)

RS(RTS)

5V

NC

NC

FG

LINE(+)

LINE(-)

3

8

1

2

5

4

6

7

9

Shell
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1I)
• 1:1 Connection

• 1:n Connection

• The cable length must be 200m or less.

PFXZCBADTM1

RDA 

RDB 

SDA 

SDB 

SG 

FG 

TRMRX 

A 

B 

SG 

Display

Display side 

Signal name 

Shield 
External Device side

Terminal block 

Signal name 

User-created cable 

R D A 

RDB 

S D A 

SDB 

SG 

FG 

TRMRX 

A 

B 

SG 

A 

B 

SG 
Display

PFXZCBADTM1

Terminal block 

Signal name 

Shield 
External Device side 

Terminal block 

Signal name 
Shield 

External Device side
Terminal block 

Signal name 

User-created cable 
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1J)
• 1:1 Connection

• 1:n Connection

• The cable length must be 200m or less.

A 

B 

SG 

External Device side 
Terminal block 

Signal name 
Display D1

D0

PFXZLMCBRJR81
GND

A 

B 

SG 

A 

B 

SG 

External Device side 
Terminal block 

Signal name 
Shield 

External Device side 
Terminal block 

Signal name 
Display D1

D0

PFXZLMCBRJR81
GND

Termination
resistance
100Ω 1/2W
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1K)
• 1:1 Connection

• 1:n Connection

• The cable length must be 200m or less.

A

B

SG

Display

Termination
resistance

Display side
D-sub 9 pin (socket)

Signal name

External Device side
Terminal blockShield

100Ω  1/2W

1

3

7

5

2
Pin

4

8

9

6

Shell

GND

DATA-

NC

NC

NC

NC

NC

NC

DATA+

Signal name

FG

100Ω  1/2W

A

B

SG

A

B

SG

Display

Termination
resistance

D-sub 9 pin (socket) Shield
External Device side

Terminal block

Signal name

Shield
External Device side

Terminal block

Signal name

1

3

7

5

2
Pin

4

8

9

6

Shell

GND

DATA-

NC

NC

NC

NC

NC

NC

DATA+

Signal name

FG

Display side
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5.2 Cable Diagram 2

2A)

2B)

Display
(Connection Port)

Cable Notes

GP3000 (COM1)
GP4000*1 (COM1)
GP6000 (COM1)
SP5000*2 (COM1/2)
SP-5B00 (COM1)
ST3000 (COM1)
ST6000 (COM1)
STM6000 (COM1)
STC6000 (COM1)
ET6000 (COM1)
LT3000 (COM1)
IPC*3

PC/AT

*1 All GP4000 models except GP-4100 series and GP-4203T

*2 Except SP-5B00

*3 Only the COM port which can communicate by RS-232C can be used.
 IPC COM Port (page 8)

2A Cable by Schneider Electric Industries
TSX PCX 1031 (2.5m)*4

*4 Set the rotary switch to "3 (OTHER DIRECT)".

GP-4105  (COM1)
GP-4115T (COM1)
GP-4115T3 (COM1) 2B

User-created cable
+

Cable by Schneider Electric Industries
TSX PCX 1031 (2.5m)*2

TSX PCX 1031

TER port
Mini DIN 8 pin

Display

External Device

TSX PCX 1031

TER port
Mini DIN 8 pin

External Device
Display

Display side
Terminal block

Signal
name

RD(RXD)

SD(TXD)

ER(DTR)

SG

RS(RTS)

CS(CTS)

External Device side
D-sub 9 pin (plug)

Pin

2

3

4

5

7

8

RD(RXD)

SD(TXD)

ER(DTR)

SG

RS(RTS)

CS(CTS)

Shield
Signal
name

User-created cable
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5.3 Cable Diagram 3

Display
(Connection Port)

Cable Notes

GP3000*1 (COM1)
AGP-3302B (COM2)
GP-4*01TM (COM1)
GP-Rear Module 
(COM1)
ST3000*2 (COM2)
LT3000 (COM1)

3A

COM Port Conversion Adapter by Pro-face
CA3-ADPCOM-01

+
Terminal Block Conversion Adapter by Pro-face

CA3-ADPTRM-01
+

User-created cable
+

Accessory box by Schneider Electric Industries
TSX SCA 50

The cable length must 
be 10m or less.*3

3B

User-created cable
+

Accessory box by Schneider Electric Industries
TSX SCA 50

GP3000*4 (COM2)

3C

Online Adapter by Pro-face
CA4-ADPONL-01

+
Terminal Block Conversion Adapter by Pro-face

CA3-ADPTRM-01
+

User-created cable
+

Accessory box by Schneider Electric Industries
TSX SCA 50

The cable length must 
be 10m or less.*3

3D

Online Adapter by Pro-face
CA4-ADPONL-01

+
User-created cable

+
Accessory box by Schneider Electric Industries

TSX SCA 50

IPC*5

3E

COM Port Conversion Adapter by Pro-face
CA3-ADPCOM-01

+
Terminal Block Conversion Adapter by Pro-face

CA3-ADPTRM-01
+

User-created cable
+

Accessory box by Schneider Electric Industries
TSX SCA 50

The cable length must 
be 10m or less.*3

3F

User-created cable
+

Accessory box by Schneider Electric Industries
TSX SCA 50
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GP-4106  (COM1)
GP-4116T (COM1) 3G

User-created cable
+

Accessory box by Schneider Electric Industries
TSX SCA 50

The cable length must 
be 10m or less.*3

GP-4107  (COM1)
GP-4*03T*6 (COM2)
GP-4203T (COM1) 3H

User-created cable
+

Accessory box by Schneider Electric Industries
TSX SCA 50

The cable length must 
be 10m or less.*3

GP4000*7 (COM2)
GP-4201T (COM1)
GP6000 (COM2)
SP5000*8 (COM1/2)
SP-5B00 (COM2)
ST6000*9 (COM2)
ST-6200 (COM1)
STM6000 (COM1)
STC6000 (COM1)
ET6000*10 (COM2)
PS6000 (Basic Box) 
(COM1/2)

3I

RS-422 Terminal Block Conversion Adapter by Pro-face
PFXZCBADTM1

*11

+
User-created cable

+
Accessory box by Schneider Electric Industries

TSX SCA 50

The cable length must 
be 10m or less.*3

3B

User-created cable
+

Accessory box by Schneider Electric Industries
TSX SCA 50

LT-4*01TM (COM1)
LT-Rear Module 
(COM1) 3J

RJ45 RS-485 Cable (5m) by Pro-face
PFXZLMCBRJR81

+
Accessory box by Schneider Electric Industries

TSX SCA 50

The cable length must 
be 5m or less.*3

PE-4000B*12

PS5000*12

PS6000 (Optional 
Interface)*12

3K

User-created cable
+

Accessory box by Schneider Electric Industries
TSX SCA 50

The cable length must 
be 10m or less.*3

*1  All GP3000 models except AGP-3302B

*2 Except AST-3211A and AST-3302B

*3 Max length between the Display and the "Accessory Box connected to Display". Total cable length between
accessory boxes must be 1000m or less (for LT-4*01TM and LT-Rear Module, 195m or less).

*4 All GP3000 models except GP-3200 series and AGP-3302B

*5 Only the COM port which can communicate by RS-422/485 (2 wire) can be used. (Except PE-4000B, PS5000,
and PS6000)
 IPC COM Port (page 8)

*6 Except GP-4203T

*7 All GP4000 models except GP-4100 series, GP-4*01TM, GP-Rear Module, GP-4201T and GP-4*03T

*8 Except SP-5B00

*9 Except ST-6200

*10 Due to the COM port specifications, flow control is not possible. Omit wiring the control pins on the Display
side of the cable diagram.

*11 When using a Terminal Block Conversion Adapter (CA3-ADPTRM-01) instead of the RS-422 Terminal Block
Conversion Adapter, refer to Cable Diagram 3A.

Display
(Connection Port)

Cable Notes
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3A)
• 1:1 Connection

• 1:n Connection

*12 Only the COM port which can communicate by RS-422/485 (2 wire) can be used.
 IPC COM Port (page 8)

• The cable length must be 10m or less.*1

*1 Max length between the Display and the "Accessory Box connected to Display". Total cable length
between accessory boxes must be 1000m or less.

RDA

RDB

SDA

SDB

SG

FG

TRMRX

D(A)

SG

SG

D(B)
Display CA3-ADPCOM-01

CA3-ADPTRM-01

Terminal block

Signal name

Shield External Device side

Signal name

Blue

White

Red

White

User-created cable

RDA

RDB

SDA

SDB

SG

FG

TRMRX

SG

SG

D(B)

D(A)

SG

SG

D(B)

D(A)Display
CA3-ADPCOM-01

CA3-ADPTRM-01

Terminal block

Signal name

Shield External Device side

Signal name

Blue

White

Red

White

Shield External Device side

Signal name

Blue

White

Red

White

User-created cable
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3B)
• 1:1 Connection

• 1:n Connection

• The cable length must be 10m or less.*1

*1 Max length between the Display and the "Accessory Box connected to Display". Total cable length
between accessory boxes must be 1000m or less.

2

3

7

5

4

SG

1

RDB

SDA

SDB

RDA

9

6

CSA

ERB

CSB

FG

ERA

8

D(A)

SG

SG

D(B)

Display Termination
resistance

D-sub 9 pin (socket)

Pin Signal name

Shell

Shield External Device side

Signal name

Blue

White

Red

White

User-created cable

Display side

2

3

7

5

4

SG

1

RDB

SDA

SDB

RDA

9

6

CSA

ERB

CSB

FG

ERA

8

D(A)

SG

SG

D(B)

D(A)

SG

SG

D(B)

Display
Termination
resistance

D-sub 9 pin (socket)

Pin Signal name

Shell

Shield External Device side

Signal name

Blue

White

Red

White

Shield External Device side

Signal name

Blue

White

Red

White

User-created cable

Display side
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3C)
• 1:1 Connection

• 1:n Connection

• The cable length must be 10m or less.*1

*1 Max length between the Display and the "Accessory Box connected to Display". Total cable length
between accessory boxes must be 1000m or less.

RDA

RDB

SDA

SDB

SG

FG

TRMRX

D(A)

SG

SG

D(B)
Display

CA4-ADPONL-01

CA3-ADPTRM-01

Terminal block

Signal name

Shield External Device side

Signal name

Blue

White

Red

White

User-created cable

RDA

RDB

SDA

SDB

SG

FG

TRMRX

SG SG

SG SG

D(B)

D(A)

D(B)

D(A)
Display

CA4-ADPONL-01

CA3-ADPTRM-01

Terminal block

Signal name

Shield External Device side

Signal name

Blue

White

Red

White

Shield External Device side

Signal name

Blue

White

Red

White

User-created cable
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3D)
• 1:1 Connection

• 1:n Connection

• The cable length must be 10m or less.*1

*1 Max length between the Display and the "Accessory Box connected to Display". Total cable length
between accessory boxes must be 1000m or less.

2

7

3

8

1

9

5

SDB

RDA

RDB

SDA

TRMRX

SG

FG

TRMRX

D(A)

SG

SG

D(B)
Display

CA4-ADPONL-01

D-sub 9 pin (plug)

Pin Signal name

Shell

Shield External Device side

Signal name

Blue

White

Red

White

User-created cable

2

7

3

8

1

9

5

SDB

RDA

RDB

SDA

TRMRX

SG

FG

TRMRX

D(A)

SG

SG

D(B)

D(A)

SG

SG

D(B)Display
CA4-ADPONL-01

D-sub 9 pin (plug)

Pin Signal name

Shell

Shield External Device side

Signal name

Blue

White

Red

White

Shield External Device side

Signal name

Blue

White

Red

White

User-created cable
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3E)
• 1:1 Connection

• 1:n Connection

• The cable length must be 10m or less.*1

*1 Max length between the Display and the "Accessory Box connected to Display". Total cable length
between accessory boxes must be 1000m or less.

RDA

RDB

SDA

SDB

SG

FG

TRMRX

D(A)

SG

SG

D(B)
Display CA3-ADPCOM-01

CA3-ADPTRM-01

Terminal block

Signal name

Shield External Device side

Signal name

Blue

White

Red

White

User-created cable

RDA

RDB

SDA

SDB

SG

FG

TRMRX

SG

SG

D(B)

D(A)

SG

SG

D(B)

D(A)Display
CA3-ADPCOM-01

CA3-ADPTRM-01

Terminal block

Signal name

Shield External Device side

Signal name

Blue

White

Red

White

Shield External Device side

Signal name

Blue

White

Red

White

User-created cable
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3F)
• 1:1 Connection

• 1:n Connection

• The cable length must be 10m or less.*1

*1 Max length between the Display and the "Accessory Box connected to Display". Total cable length
between accessory boxes must be 1000m or less.

2

3

7

5 GND(SG)

1

DATA-

NC

NC

DATA+

D(A)

SG

SG

D(B)Display

Termination
resistance
100Ω  1/2W

D-sub 9 pin (socket)

Pin Signal name

Shield External Device side

Signal name

Blue

White

Red

White

ERA

CSA

ERB

CSB

FG

4

8

9

6

Shell

User-created cable

Display side

2

3

7

5 GND(SG)

1

DATA-

NC

NC

DATA+Display

Termination
resistance
100Ω  1/2W

D-sub 9 pin (socket)

Pin Signal name

Shield

D(A)

SG

SG

D(B)

D(A)

SG

SG

D(B)

External Device side

Signal name

Blue

White

Red

White

Shield External Device side

Signal name

Blue

White

Red

White

ERA

CSA

ERB

CSB

FG

4

8

9

6

Shell

User-created cable

Display side
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3G)
• 1:1 Connection

• 1:n Connection

D(A)

SG

SG

D(B)

Display Termination
resistance*1

 Display side 
Terminal block Shield External Device side

Signal name

Blue

White

Red

White

User-created cable

RDB

SDA

SDB

RDA

CSA

ERB

CSB

ERA

Signal name

SG

D(A)

SG

SG

D(B)

D(A)

SG

SG

D(B)

Display
Termination
resistance*1

Shield External Device side

Signal name

Blue

White

Red

White

Shield External Device side

Signal name

Blue

White

Red

White

User-created cable

 Display side 
Terminal block

RDB

SDA

SDB

RDA

CSA

ERB

CSB

ERA

Signal name

SG
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*1 The resistance in the Display is used as the termination resistance. Set the value of the DIP Switch on the 
rear of the Display as shown in the table below.    

DIP Switch No. Set Value

1 OFF

2 OFF

3 ON

4 ON

• The cable length must be 10m or less.*1

*1 Max length between the Display and the "Accessory Box connected to Display". Total cable length
between accessory boxes must be 1000m or less.
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3H) 
• 1:1 Connection

• 1:n Connection

• The 5V output (Pin #6) on the Display is the power for the Siemens AG’s PROFIBUS 
connector. Do not use it for other devices.

• In COM on the GP-4107, the SG and FG terminals are isolated.
• The cable length must be 10m or less.*1

*1 Max length between the Display and the "Accessory Box connected to Display". Total cable length
between accessory boxes must be 1000m or less.

D(A)

SG

SG

D(B)Display

Termination
resistance
100Ω  1/2W

Shield External Device side

Signal name

Blue

White

Red

White

User-created cable

Pin Signal name

Display side
D-Sub 9pin (plug)

NC

NC

GND(SG)

RS(RTS)

5V

NC

NC

FG

LINE(+)

LINE(-)

3

8

1

2

5

4

6

7

9

Shell

Display

Termination
resistance
100Ω  1/2W

Shield

D(A)

SG

SG

D(B)

D(A)

SG

SG

D(B)

External Device side

Signal name

Blue

White

Red

White

Shield External Device side

Signal name

Blue

White

Red

White

User-created cable

Pin Signal name

Display side
D-Sub 9pin (plug)

NC

NC

GND(SG)

RS(RTS)

5V

NC

NC

FG

LINE(+)

LINE(-)

3

8

1

2

5

4

6

7

9

Shell
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3I)
• 1:1 Connection

• 1:n Connection

• The cable length must be 10m or less.*1

*1 Max length between the Display and the "Accessory Box connected to Display". Total cable length
between accessory boxes must be 1000m or less.

R D A 

RDB 

S D A 

SDB 

SG 

FG 

TRMRX 

D(A) 

SG 

SG 

D(B) 
Display

PFXZCBADTM1

Terminal block 

Signal name 

Shield External Device side 

Signal name 

Blue 

White 

Red 

White 

User-created cable 

R D A 

RDB 

S D A 

SDB 

SG 

FG 

TRMRX 

SG 

SG 

D(B) 

D(A) 

SG 

SG 

D(B) 

D(A) Display

PFXZCBADTM1

Terminal block 

Signal name 

Shield External Device side 

Signal name 

Blue 

White 

Red 

White 

Shield External Device side

Signal name 

Blue 

White 

Red 

White 

User-created cable 
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3J)
• 1:1 Connection

• 1:n Connection

• The cable length must be 5m or less.*1

*1 Max length between the Display and the "Accessory Box connected to Display". Total cable length
between accessory boxes must be 195 or less.

D(A) 

SG 

SG 

D(B) 

External Device side 

Signal name 

Blue 

White 

Red 

White 

Display
D1

D0

PFXZLMCBRJR81

GND

SG 

SG 

D(B) 

D(A) 

SG 

SG 

D(B) 

D(A) 

External Device side 

Signal name 

Blue 

White 

Red 

White 

Shield External Device side 

Signal name 

Blue 

White 

Red 

White 

Display D1

D0

PFXZLMCBRJR81

GND

Termination
resistance
100Ω 1/2W
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3K)
• 1:1 Connection

• 1:n Connection

• The cable length must be 10m or less.*1

*1 Max length between the Display and the "Accessory Box connected to Display". Total cable length
between accessory boxes must be 1000m or less.

1

3

7

5 GND

2

DATA-

NC

NC

NC

NC

NC

NC

DATA+

D(A)

SG

SG

D(B)Display

Termination
resistance
100Ω  1/2W

D-sub 9 pin (socket)

Pin Signal name

Shield External Device side

Signal name

Blue

White

Red

White

FG

4

8

9

6

Shell

User-created cable

Display side

1

3

7

5 GND

2

DATA-

NC

NC

NC

NC

NC

NC

DATA+Display

Termination
resistance
100Ω  1/2W

D-sub 9 pin (socket)

Pin Signal name

Shield

D(A)

SG

SG

D(B)

D(A)

SG

SG

D(B)

External Device side

Signal name

Blue

White

Red

White

Shield External Device side

Signal name

Blue

White

Red

White

FG

4

8

9

6

Shell

User-created cable

Display side
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5.4 Cable Diagram 4

Display
(Connection Port)

Cable Notes

GP3000 (COM1)
GP4000*1 (COM1)
GP6000 (COM1)
SP5000*2 (COM1/2)
SP-5B00 (COM1)
ST3000 (COM1)
ST6000 (COM1)
STM6000 (COM1)
STC6000 (COM1)
ET6000 (COM1)
LT3000 (COM1)
IPC*3

PC/AT

*1 All GP4000 models except GP-4100 series and GP-4203T

*2 Except SP-5B00

*3 Only the COM port which can communicate by RS-232C can be used.
 IPC COM Port (page 8)

4A

User-created cable
+

RS 232 D tap link cable by Schneider Electric
TSX SCP CC 1030 (3m)

+
PCMCIA card for RS232C by Schneider Electric

TSX SCP 111

The cable length must 
be 15m or less.*4

*4 Total length for TSX SCP CC 1030 and User-created cable.

GP-4105  (COM1)
GP-4115T (COM1)
GP-4115T3 (COM1) 4B

User-created cable
+

RS 232 D tap link cable by Schneider Electric
TSX SCP CC 1030 (3m)

+
PCMCIA card for RS232C by Schneider Electric

TSX SCP 111

The cable length must 
be 15m or less.*4

LT-4*01TM (COM1)
LT-Rear Module (COM1) 4C

RJ45 RS-232C Cable (5m) by Pro-face
PFXZLMCBRJR21

+
RS 232 D tap link cable by Schneider Electric

TSX SCP CC 1030 (3m)
+

PCMCIA card for RS232C by Schneider Electric
TSX SCP 111

The cable length must 
be 8m or less.
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4A)

4B)

• The cable length must be 15m or less. *1

*1 Total length for TSX SCP CC 1030 and User-created cable.

• The cable length must be 15m or less. *1

*1 Total length for TSX SCP CC 1030 and User-created cable.

3

4

6

7

8

2

SG

FG

5

3

4

5

20

6

DTR

2

RXD

RTS

CTS

TXD

SG

DSR

7

Display

D-sub 9 pin (socket)

Pin Signal name

Shell

Shield

External Device side
D-sub 25 pin (socket)

Pin Signal name
TSX SCP 111

TSX SCP CC 1030

User-created cable

RD(RXD)

SD(TXD)

ER(DTR)

DR(DSR)

RS(RTS)

CS(CTS)

Display side

3

4

5

20

6

DTR

2

RXD

RTS

CTS

TXD

SG

DSR

7

Display

Signal name

Shield

External Device side
D-sub 25 pin (socket)

Pin Signal name
TSX SCP 111

TSX SCP CC 1030

User-created cable

 Display side 
Terminal block

SG

RD(RXD)

SD(TXD)

ER(DTR)

DR(DSR)

RS(RTS)

CS(CTS)
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4C)

• The cable length must be 8m or less. *1

*1 Total length for TSX SCP CC 1030 and User-created cable.

3

4

5

20

6

DTR

2

RXD

RTS

CTS

TXD

SG

DSR

7

External Device side
D-sub 25 pin (socket)

Pin Signal name
TSX SCP 111

TSX SCP CC 1030

Display
RXD

TXD

PFXZLMCBRJR21

GND
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5.5 Cable Diagram 5

Display
(Connection Port)

Cable Notes

GP3000*1 (COM1)
AGP-3302B (COM2)
GP-4*01TM (COM1)
GP-Rear Module 
(COM1)
ST3000*2 (COM2)
LT3000 (COM1)

5A

COM Port Conversion Adapter by Pro-face
CA3-ADPCOM-01

+
Terminal Block Conversion Adapter by Pro-face

CA3-ADPTRM-01
+

User-created cable
+

Uni-Telway cable by Schneider Electric Industries
TSX SCP CU 4030 (3m)

+
PCMCIA card for RS485 by Schneider Electric Industries

TSX SCP 114

5B

User-created cable
+

Uni-Telway cable by Schneider Electric Industries
TSX SCP CU 4030 (3m)

+
PCMCIA card for RS485 by Schneider Electric Industries

TSX SCP 114

GP3000*3 (COM2)

5C

Online Adapter by Pro-face
CA4-ADPONL-01

+
Terminal Block Conversion Adapter by Pro-face

CA3-ADPTRM-01
+

User-created cable
+

Uni-Telway cable by Schneider Electric Industries
TSX SCP CU 4030 (3m)

+
PCMCIA card for RS485 by Schneider Electric Industries

TSX SCP 114

5D

Online Adapter by Pro-face
CA4-ADPONL-01

+
User-created cable

+
Uni-Telway cable by Schneider Electric Industries

TSX SCP CU 4030 (3m)
+

PCMCIA card for RS485 by Schneider Electric Industries
TSX SCP 114
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IPC*4

5E

COM Port Conversion Adapter by Pro-face
CA3-ADPCOM-01

+
Terminal Block Conversion Adapter by Pro-face

CA3-ADPTRM-01
+

User-created cable
+

Uni-Telway cable by Schneider Electric Industries
TSX SCP CU 4030 (3m)

+
PCMCIA card for RS485 by Schneider Electric Industries

TSX SCP 114

5F

User-created cable
+

Uni-Telway cable by Schneider Electric Industries
TSX SCP CU 4030 (3m)

+
PCMCIA card for RS485 by Schneider Electric Industries

TSX SCP 114

GP-4106  (COM1)
GP-4116T (COM1) 5G

User-created cable
+

Uni-Telway cable by Schneider Electric Industries
TSX SCP CU 4030 (3m)

+
PCMCIA card for RS485 by Schneider Electric Industries

TSX SCP 114

GP-4107  (COM1)
GP-4*03T*5 (COM2)
GP-4203T (COM1) 5H

User-created cable
+

Uni-Telway cable by Schneider Electric Industries
TSX SCP CU 4030 (3m)

+
PCMCIA card for RS485 by Schneider Electric Industries

TSX SCP 114

GP4000*6 (COM2)
GP-4201T (COM1)
GP6000 (COM2)
SP5000*7 (COM1/2)
SP-5B00 (COM2)
ST6000*8 (COM2)
ST-6200 (COM1)
STM6000 (COM1)
STC6000 (COM1)
ET6000*9 (COM2)
PS6000 (Basic Box) 
(COM1/2)

5I

RS-422 Terminal Block Conversion Adapter by Pro-face
PFXZCBADTM1

*10

+
User-created cable

+
Uni-Telway cable by Schneider Electric Industries

TSX SCP CU 4030 (3m)
+

PCMCIA card for RS485 by Schneider Electric Industries
TSX SCP 114

5B

User-created cable
+

Uni-Telway cable by Schneider Electric Industries
TSX SCP CU 4030 (3m)

+
PCMCIA card for RS485 by Schneider Electric Industries

TSX SCP 114

Display
(Connection Port)

Cable Notes
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5A)

LT-4*01TM (COM1)
LT-Rear Module 
(COM1) 5J

RJ45 RS-485 Cable (5m) by Pro-face
PFXZLMCBRJR81

+
Uni-Telway cable by Schneider Electric Industries

TSX SCP CU 4030 (3m)
+

PCMCIA card for RS485 by Schneider Electric Industries
TSX SCP 114

PE-4000B*11

PS5000*11

PS6000 (Optional 
Interface)*11

5K

User-created cable
+

Uni-Telway cable by Schneider Electric Industries
TSX SCP CU 4030 (3m)

+
PCMCIA card for RS485 by Schneider Electric Industries

TSX SCP 114

*1  All GP3000 models except AGP-3302B

*2 Except AST-3211A and AST-3302B

*3 All GP3000 models except GP-3200 series and AGP-3302B

*4 Only the COM port which can communicate by RS-422/485 (2 wire) can be used. (Except PE-4000B, PS5000,
and PS6000)
 IPC COM Port (page 8)

*5 Except GP-4203T

*6 All GP4000 models except GP-4100 series, GP-4*01TM, GP-Rear Module, GP-4201T and GP-4*03T

*7 Except SP-5B00

*8 Except ST-6200

*9 Due to the COM port specifications, flow control is not possible. Omit wiring the control pins on the Display
side of the cable diagram.

*10 When using a Terminal Block Conversion Adapter (CA3-ADPTRM-01) instead of the RS-422 Terminal Block
Conversion Adapter, refer to Cable Diagram 5A.

*11 Only the COM port which can communicate by RS-422/485 (2 wire) can be used.
 IPC COM Port (page 8)

Display
(Connection Port)

Cable Notes

RDA

RDB

SDA

SDB

SG

FG

TRMRX

D(A)

SG

SG

D(B)
Display CA3-ADPCOM-01

CA3-ADPTRM-01

Terminal block

Signal name

Shield External Device side

Signal name

Blue

White

Red

White

TSX SCP 114

TSX SCP CU 4030

User-created cable
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5B)

5C)

2

3

7

5

4

SG

1

RDB

SDA

SDB

RDA

9

6

CSA

ERB

CSB

FG

ERA

8

D(A)

SG

SG

D(B)

Display

Termination
resistance

D-sub 9 pin (socket)

Pin Signal name

Shell

Shield External Device side

Signal name

Blue

White

Red

White

TSX SCP 114

TSX SCP CU 4030

User-created cable

Display side

RDA

RDB

SDA

SDB

SG

FG

TRMRX

D(A)

SG

SG

D(B)
Display

CA4-ADPONL-01

CA3-ADPTRM-01

Terminal block

Signal name

Shield External Device side

Signal name

Blue

White

Red

White

TSX SCP 114

TSX SCP CU 4030

User-created cable
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5D)

5E)

D(A)

SG

SG

D(B)Display

CA4-ADPONL-01

D-sub 9 pin (plug) Shield External Device side

Signal name

Blue

White

Red

White

TSX SCP 114

TSX SCP CU 4030

User-created cable

Signal name

SDA

RDB

SDB

RDA

3

2

1

5

7

9

8

Pin

TRMRX

SG

FG

TRMRX

Shell

RDA

RDB

SDA

SDB

SG

FG

TRMRX

D(A)

SG

SG

D(B)
Display CA3-ADPCOM-01

CA3-ADPTRM-01

Terminal block

Signal name

Shield External Device side

Signal name

Blue

White

Red

White

TSX SCP 114

TSX SCP CU 4030

User-created cable
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5F)

2

3

7

5

4

GND(SG)

1

DATA-

NC

NC

DATA+

9

6

CSA

ERB

CSB

FG

ERA

8

D(A)

SG

SG

D(B)

Display

Termination
resistance

D-sub 9 pin (socket)

Pin Signal name

Shell

Shield External Device side

Signal name

Blue

White

Red

White

TSX SCP 114

TSX SCP CU 4030

User-created cable

Display side



MODBUS SIO Master Driver

GP-Pro EX Device/PLC Connection Manual 105

5G)

*1 The resistance in the Display is used as the termination resistance. Set the value of the DIP Switch on the 
rear of the Display as shown in the table below. 

DIP Switch No. Set Value

1 OFF

2 OFF

3 ON

4 ON

SG

RDB

SDA

SDB

RDA

CSA

ERB

CSB

ERA

D(A)

SG

SG

D(B)

Display

Termination
resistance*1

  Display side 
Terminal block

Signal name

Shield External Device side

Signal name

Blue

White

Red

White

TSX SCP 114

TSX SCP CU 4030

User-created cable
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5H)

5I)

• The 5V output (Pin #6) on the Display is the power for the Siemens AG’s PROFIBUS 
connector. Do not use it for other devices.

• In COM on the GP-4107, the SG and FG terminals are isolated.

D(A)

SG

SG

D(B)

Display

Termination
resistance

Pin Signal name

Shield External Device side

Signal name

Blue

White

Red

White

TSX SCP 114

TSX SCP CU 4030

User-created cable

Display side
D-sub 9 pin (plug)

3

8

1

2

5

4

6

7

9

Shell

NC

NC

GND(SG)

RS(RTS)

5V

NC

NC

FG

LINE(+)

LINE(-)

RDA

RDB

SDA

SDB

SG

FG

TRMRX

D(A)

SG

SG

D(B)
Display

PFXZCBADTM1

Terminal block

Signal name

Shield External Device side

Signal name

Blue

White

Red

White

TSX SCP 114

TSX SCP CU 4030

User-created cable
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5J)

5K)

D(A)

SG

SG

D(B)

External Device side

Signal name

Blue

White

Red

White

TSX SCP 114

TSX SCP CU 4030

Display
D1

D0

PFXZLMCBRJR81
GND

1

3

7

5

4

GND

2

DATA-

NC

NC

NC

NC

NC

NC

DATA+

9

6

FG

8

D(A)

SG

SG

D(B)

Display

Termination
resistance

D-sub 9 pin (socket)

Pin Signal name

Shell

Shield External Device side

Signal name

Blue

White

Red

White

TSX SCP 114

TSX SCP CU 4030

User-created cable

Display side
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5.6 Cable Diagram 6

6A)

Display
(Connection Port)

Cable Notes

GP3000 (COM1)
GP4000*1 (COM1)
GP6000 (COM1)
SP5000*2 (COM1/2)
SP-5B00 (COM1)
ST3000 (COM1)
ST6000 (COM1)
STM6000 (COM1)
STC6000 (COM1)
ET6000 (COM1)
LT3000 (COM1)
IPC*3

PC/AT

*1 All GP4000 models except GP-4100 series and GP-4203T

*2 Except SP-5B00

*3 Only the COM port which can communicate by RS-232C can be used.
 IPC COM Port (page 8)

6A User-created cable The cable length must be 
15m or less.

GP-4105  (COM1)
GP-4115T (COM1)
GP-4115T3 (COM1) 6B User-created cable The cable length must be 

15m or less.

LT-4*01TM (COM1)
LT-Rear Module (COM1) 6C

RJ45 RS-232C Cable (5m) by Pro-face
PFXZLMCBRJR21 The cable length must be 

5m or less.

3

4

5

6

7

2

8

3

5

4

6

7

DSR

2

TXD

SG

DTR

RXD

CTS

RTS

8

Display

D-sub 9 pin (socket)

Pin Signal name

Shield

Shell

External Device side
D-sub 9 pin (plug)

Pin Signal name

User-created cable

DR(DSR)

SD(TXD)

ER(DTR)

SG

RD(RXD)

CS(CTS)

RS(RTS)

FG

Display side



MODBUS SIO Master Driver

GP-Pro EX Device/PLC Connection Manual 109

6B)

6C)

• The cable length must be 15m or less.

• The cable length must be 15m or less.

• The cable length must be 5m or less.

3

5

4

6

7

DSR

2

TXD

SG

DTR

RXD

CTS

RTS

8

Display

Signal name

Shield
External Device side

D-sub 9 pin (plug)

Pin Signal name

User-created cable

   Display side 
Terminal block

DR(DSR)

SD(TXD)

ER(DTR)

SG

RD(RXD)

CS(CTS)

RS(RTS)

3

5

4

6

7

DSR

2

TXD

SG

DTR

RXD

CTS

RTS

8

External Device side
D-sub 9 pin (plug)

Pin Signal name
Display

TXD

RXD

PFXZLMCBRJR21
GND
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5.7 Cable Diagram 7

7A)

Display
(Connection Port)

Cable Notes

GP3000 (COM1)
GP4000*1 (COM1)
GP6000 (COM1)
SP5000*2 (COM1/2)
SP-5B00 (COM1)
ST3000 (COM1)
ST6000 (COM1)
STM6000 (COM1)
STC6000 (COM1)
ET6000 (COM1)
LT3000 (COM1)
IPC*3

PC/AT

*1 All GP4000 models except GP-4100 series and GP-4203T

*2 Except SP-5B00

*3 Only the COM port which can communicate by RS-232C can be used.
 IPC COM Port (page 8)

7A

D-Shell adapter by Schneider Electric
 110 XCA 203 00

+
RS232 communication cable RJ45 to RJ45 by Schneider Electric

110 XCA 282 01(1m), 110 XCA 282 02(3m) or 110 XCA 282 03(6m)

The cable 
length must 
be 9.5m or 
less.

GP-4105  (COM1)
GP-4115T (COM1)
GP-4115T3 (COM1) 7B

User-created cable
+

D-Shell adapter by Schneider Electric
 110 XCA 203 00

+
RS232 communication cable RJ45 to RJ45 by Schneider Electric

110 XCA 282 01(1m), 110 XCA 282 02(3m) or 110 XCA 282 03(6m)

The cable 
length must 
be 9.5m or 
less.

• The cable length must be 9.5m or less.

Display

110 XCA 203 00

110 XCA 282 01
or

110 XCA 282 02
or

110 XCA 282 03

Extermal Device

Modbus port 1
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7B)

• The cable length must be 9.5m or less.

110 XCA 203 00

110 XCA 282 01
or

110 XCA 282 02
or

110 XCA 282 03

Extermal Device

Modbus port 1

Display

Display side
Terminal block

Signal
name

RD(RXD)

SD(TXD)

ER(DTR)

SG

RS(RTS)

CS(CTS)

External Device side
D-sub 9 pin (plug)

Pin

2

3

4

5

7

8

RD(RXD)

SD(TXD)

ER(DTR)

SG

RS(RTS)

CS(CTS)

Shield
Signal
name

User-created cable



MODBUS SIO Master Driver

GP-Pro EX Device/PLC Connection Manual 112

5.8 Cable Diagram 8

Display
(Connection Port)

Cable Notes

GP3000*1 (COM1)
AGP-3302B (COM2)
GP-4*01TM (COM1)
GP-Rear Module 
(COM1)
ST3000*2 (COM2)
LT3000 (COM1)
IPC*3

*1  All GP3000 models except AGP-3302B

*2 Except AST-3211A and AST-3302B

*3 Only the COM port which can communicate by RS-422/485 (4 wire) can be used. (Except PE-4000B, PS5000,
and PS6000)
 IPC COM Port (page 8)

8A

COM Port Conversion Adapter by Pro-face
CA3-ADPCOM-01

+
Terminal Block Conversion Adapter by Pro-face

CA3-ADPTRM-01
+

User-created cable

The cable length 
must be 500m or less.

8B User-created cable

GP3000*4 (COM2)

*4 All GP3000 models except GP-3200 series and AGP-3302B

8C

Online Adapter by Pro-face
CA4-ADPONL-01

+
Terminal Block Conversion Adapter by Pro-face

CA3-ADPTRM-01
+

User-created cable
The cable length 
must be 500m or less.

8D

Online Adapter by Pro-face
CA4-ADPONL-01

+
User-created cable

GP-4106  (COM1)
GP-4116T (COM1) 8E User-created cable The cable length 

must be 500m or less.

GP4000*5 (COM2)
GP-4201T (COM1)
GP6000 (COM2)
SP5000*6 (COM1/2)
SP-5B00 (COM2)
ST6000*7 (COM2)
ST-6200 (COM1)
STM6000 (COM1)
STC6000 (COM1)
ET6000*8 (COM2)
PS6000 (Basic Box) 
(COM1/2)

*5 All GP4000 models except GP-4100 series, GP-4*01TM, GP-Rear Module, GP-4201T and GP-4*03T

8F

RS-422 Terminal Block Conversion Adapter by Pro-face
PFXZCBADTM1

*9

+
User-created cable

The cable length 
must be 500m or less.

8B User-created cable

PE-4000B*10

PS5000*10

PS6000 (Optional 
Interface)*10

8G User-created cable The cable length 
must be 500m or less.



MODBUS SIO Master Driver

GP-Pro EX Device/PLC Connection Manual 113

8A)

8B)

*6 Except SP-5B00

*7 Except ST-6200

*8 Due to the COM port specifications, flow control is not possible. Omit wiring the control pins on the Display
side of the cable diagram.

*9 When using a Terminal Block Conversion Adapter (CA3-ADPTRM-01) instead of the RS-422 Terminal Block
Conversion Adapter, refer to Cable Diagram 8A.

*10 Only the COM port which can communicate by RS-422/485 (4 wire) can be used.
 IPC COM Port (page 8)

• The cable length must be 500m or less.

• The cable length must be 500m or less.

RDA

RDB

SDA

SDB

SG

FG

TRMRX

6

2

7

3 SG

1

TXD-

RXD+

RXD-

TXD+
Display CA3-ADPCOM-01

CA3-ADPTRM-01

Terminal block

Signal name

Shield
External Device Modbus port 2

D-sub 9 pin (plug)

Pin Signal name

User-created cable

6

2

7

3 SG

1

TXD-

RXD+

RXD-

TXD+

2

3

7

5

4

SG

1

RDB

SDA

SDB

RDA

9

6

CSA

ERB

CSB

FG

ERA

8

Display Termination
resistance

D-sub 9 pin (socket)

Pin Signal name

Shell

Shield
External Device Modbus port 2

D-sub 9 pin (plug)

Pin Signal name

Display side
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8C)

8D)

• The cable length must be 500m or less.

• The cable length must be 500m or less.

6

2

7

3 SG

1

TXD-

RXD+

RXD-

TXD+RDA

RDB

SDA

SDB

SG

FG

TRMRX

Display CA4-ADPONL-01

CA3-ADPTRM-01

Terminal block

Signal name

Shield
External Device Modbus port 2

D-sub 9 pin (plug)

Pin Signal name

User-created cable

6

2

7

3 SG

1

TXD-

RXD+

RXD-

TXD+2

7

3

8

9

1

5

SDB

RDA

RDB

SDA

TRMRX

SG

FG

TRMRX

Display
CA4-ADPONL-01

D-sub 9 pin (plug)

Pin Signal name

Shell

Shield
External Device Modbus port 2

D-sub 9 pin (plug)

Pin Signal name

User-created cable
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8E)

*1 The resistance in the Display is used as the termination resistance. Set the value of the DIP Switch on the 
rear of the Display as shown in the table below.    

• The cable length must be 500m or less.

DIP Switch No. Set Value

1 OFF

2 OFF

3 ON

4 ON

6

2

7

3 SG

1

TXD-

RXD+

RXD-

TXD+

Display Termination
resistance*1

Shield
External Device Modbus port 2

D-sub 9 pin (plug)

Pin Signal name

 Display side 
Terminal block

RDB

SDA

SDB

RDA

CSA

ERB

CSB

ERA

Signal name

SG
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8F)

8G)

• The cable length must be 500m or less.

• The cable length must be 500m or less.

RDA

RDB

SDA

SDB

SG

FG

TRMRX

6

2

7

3 SG

1

TXD-

RXD+

RXD-

TXD+
Display

PFXZCBADTM1

Terminal block

Signal name

Shield
External Device Modbus port 2

D-sub 9 pin (plug)

Pin Signal name

User-created cable

6

2

7

3 SG

1

TXD-

RXD+

RXD-

TXD+

4

2

1

5

7

3 Rx+

Rx-

Tx+

Tx-

GND

NC

NC

NC

NC

9

6

FG

8

Display Termination
resistance

D-sub 9 pin (socket)

Pin Signal name

Shell

Shield
External Device Modbus port 2

D-sub 9 pin (plug)

Pin Signal name

Display side
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5.9 Cable Diagram 9

Display
(Connection Port)

Cable Notes

GP3000 (COM1)
GP4000*1 (COM1)
GP6000 (COM1)
SP5000*2 (COM1/2)
SP-5B00 (COM1)
ST3000 (COM1)
ST6000 (COM1)
STM6000 (COM1)
STC6000 (COM1)
ET6000 (COM1)
LT3000 (COM1)
IPC*3

PC/AT

*1 All GP4000 models except GP-4100 series and GP-4203T

*2 Except SP-5B00

*3 Only the COM port which can communicate by RS-232C can be used.
 IPC COM Port (page 8)

9A User-created cable The cable length must be 
15m or less.

GP-4105  (COM1)
GP-4115T (COM1)
GP-4115T3 (COM1) 9B User-created cable The cable length must be 

15m or less.
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9A)

9B)

• The cable length must be 15m or less.

• The cable length must be 15m or less.

Shield

3

4

5

7

8

D-sub 9 pin (socket)

2

Pin Signal name

Shell

RS(RTS)

SD(TXD)

ER(DTR)

SG

RD(RXD)

FG

CS(CTS)

6

5

7

8

External Device side
D-sub 9 pin (socket)

Display side

RS

2

Pin Signal name

DR

SG

RD

CS

Display

3 SD

ShieldTerminal block

Signal name

RS(RTS)

SD(TXD)

ER(DTR)

SG

RD(RXD)

CS(CTS)

6

5

7

8

External Device side
D-sub 9 pin (socket)

Display side

RS

2

Pin Signal name

DR

SG

RD

CS

Display

3 SD
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5.10 Cable Diagram 10

10A)

Display
(Connection Port)

Cable Notes

GP3000 (COM1)
GP4000*1 (COM1)
GP6000 (COM1)
SP5000*2 (COM1/2)
SP-5B00 (COM1)
ST3000 (COM1)
ST6000 (COM1)
STM6000 (COM1)
STC6000 (COM1)
ET6000 (COM1)
LT3000 (COM1)
IPC*3

PC/AT

*1 All GP4000 models except GP-4100 series and GP-4203T

*2 Except SP-5B00

*3 Only the COM port which can communicate by RS-232C can be used.
 IPC COM Port (page 8)

10A User-created cable The cable length must be 
15m or less.

GP-4105  (COM1)
GP-4115T (COM1)
GP-4115T3 (COM1) 10B User-created cable The cable length must be 

15m or less.

• The cable length must be 15m or less.

Shield

3

4

5

7

8

D-sub 9 pin (socket)

2

Pin Signal name

Shell

RS(RTS)

SD(TXD)

ER(DTR)

SG

RD(RXD)

FG

CS(CTS)

6

5

7

8

External Device side
D-sub 9 pin (plug)

RS

2

Pin Signal name

DR

SG

RD

CS

Display

1 CD

3 SD

Display side
Shield

3

4

5

7

8

D-sub 9 pin (socket)

2

Pin Signal name

Shell

RS(RTS)

SD(TXD)

ER(DTR)

SG

RD(RXD)

FG

CS(CTS)

6

5

7

8

External Device side
D-sub 9 pin (plug)

RS

2

Pin Signal name

DR

SG

RD

CS

Display

1 CD

3 SD

Display side
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10B)

• The cable length must be 15m or less.

Shield

6

5

7

8

External Device side
D-sub 9 pin (plug)

RS

2

Pin Signal name

DR

SG

RD

CS

Display

1 CD

3 SD

Terminal block
Display side

Signal name

RS(RTS)

SD(TXD)

ER(DTR)

SG

RD(RXD)

CS(CTS)
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5.11 Cable Diagram 11

Display
(Connection Port)

Cable Notes

GP3000*1 (COM1)
AGP-3302B (COM2)
GP-4*01TM (COM1)
GP-Rear Module 
(COM1)
ST3000*2 (COM2)
LT3000 (COM1)
IPC*3

*1  All GP3000 models except AGP-3302B

*2 Except AST-3211A and AST-3302B

*3 Only the COM port which can communicate by RS-422/485 (4 wire) can be used. (Except PE-4000B, PS5000,
and PS6000)
 IPC COM Port (page 8)

11A

COM Port Conversion Adapter by Pro-face
CA3-ADPCOM-01

+
Terminal Block Conversion Adapter by Pro-face

CA3-ADPTRM-01
+

User-created cable

The cable length 
must be 1000m or 
less.

11B User-created cable

GP3000*4 (COM2)

*4 All GP3000 models except GP-3200 series and AGP-3302B

11C

Online Adapter by Pro-face
CA4-ADPONL-01

+
Terminal Block Conversion Adapter by Pro-face

CA3-ADPTRM-01
+

User-created cable

The cable length 
must be 1000m or 
less.

11D

Online Adapter by Pro-face
CA4-ADPONL-01

+
User-created cable

GP-4106  (COM1)
GP-4116T (COM1) 11E User-created cable

The cable length 
must be 1000m or 
less.

GP4000*5 (COM2)
GP-4201T (COM1)
GP6000 (COM2)
SP5000*6 (COM1/2)
SP-5B00 (COM2)
ST6000*7 (COM2)
ST-6200 (COM1)
STM6000 (COM1)
STC6000 (COM1)
ET6000*8 (COM2)
PS6000 (Basic Box) 
(COM1/2)

*5 All GP4000 models except GP-4100 series, GP-4*01TM, GP-Rear Module, GP-4201T and GP-4*03T

11F

RS-422 Terminal Block Conversion Adapter by Pro-face
PFXZCBADTM1

*9

+
User-created cable

The cable length 
must be 1000m or 
less.

11B User-created cable

PE-4000B*10

PS5000*10

PS6000 (Optional 
Interface)*10

11G User-created cable
The cable length 
must be 1000m or 
less.
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11A)
• 1:1 Connection

• 1:n Connection

*6 Except SP-5B00

*7 Except ST-6200

*8 Due to the COM port specifications, flow control is not possible. Omit wiring the control pins on the Display
side of the cable diagram.

*9 When using a Terminal Block Conversion Adapter (CA3-ADPTRM-01) instead of the RS-422 Terminal Block
Conversion Adapter, refer to Cable Diagram 11A.

*10 Only the COM port which can communicate by RS-422/485 (4 wire) can be used.
 IPC COM Port (page 8)

• The cable length must be 1000m or less.

Display

CA3-ADPTRM-01

CA3-ADPCOM-01

Shield

Terminal block

TERM

RDA

RDB

SDA

Signal name

SG

FG

SDB

External Device side
RS-422/485

Communication
Terminal block

SG

Signal name

Tx-

RX+

RX-

Tx+

Termination
resistance
120Ω 1/2W

Termination
resistance
120Ω 1/2W

Display side

User-created cable

Display

CA3-ADPTRM-01

CA3-ADPCOM-01

Shield

Terminal block

TERM

RDA

RDB

SDA

Signal name

SG

FG

SDB

External Device side
RS-422/485

Communication
Terminal block

SG

Signal name

Tx-

RX+

RX-

Tx+

Termination
resistance
120Ω 1/2W

Shield

External Device side
RS-422/485

Communication
Terminal block

SG

Signal name

Tx-

RX+

RX-

Tx+
Termination
resistance
120Ω 1/2W

Display side

User-created cable
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11B)
• 1:1 Connection

• 1:n Connection

• The cable length must be 1000m or less.

Shield

External Device side
RS-422/485

Communication
Terminal block

SG

Signal name

Tx-

RX+

RX-

Tx+

2

3

7

5

4

D-sub 9 pin (socket)

SG

1

Pin Signal name

RDB

SDA

SDB

RDA

9

6

CSA

ERB

CSB

FG

ERA

Shell

8

Termination
resistance
120Ω 1/2W

Display

Termination
resistance
120Ω 1/2W

Display side

Shield

External Device side
RS-422/485

Communication
Terminal block

SG

Signal name

Tx-

RX+

RX-

Tx+

2

3

7

5

4

D-sub 9 pin (socket)

SG

1

Pin Signal name

RDB

SDA

SDB

RDA

9

6

CSA

ERB

CSB

FG

ERA

Shell

8

Termination
resistance
120Ω 1/2W

Display

Shield

External Device side
RS-422/485

Communication
Terminal block

SG

Signal name

Tx-

RX+

RX-

Tx+
Termination
resistance
120Ω 1/2W

Display side
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11C)
• 1:1 Connection

• 1:n Connection

• The cable length must be 1000m or less.

Display

CA3-ADPTRM-01

CA4-ADPONL-01

Shield

Terminal block

TERM

RDA

RDB

SDA

Signal name

SG

FG

SDB

External Device side
RS-422/485

Communication
Terminal block

SG

Signal name

Tx-

RX+

RX-

Tx+

Termination
resistance
120Ω 1/2W

Termination
resistance
120Ω 1/2W

Display side

User-created cable

Display

CA3-ADPTRM-01

CA4-ADPONL-01

Shield

Terminal block

TERM

RDA

RDB

SDA

Signal name

SG

FG

SDB

External Device side
RS-422/485

Communication
Terminal block

SG

Signal name

Tx-

RX+

RX-

Tx+

Termination
resistance
120Ω 1/2W

Shield

External Device side
RS-422/485

Communication
Terminal block

SG

Signal name

Tx-

RX+

RX-

Tx+
Termination
resistance
120Ω 1/2W

Display side

User-created cable
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11D)
• 1:1 Connection

• 1:n Connection

• The cable length must be 1000m or less.

7

3

8

5

D-sub 9 pin (plug)

2

Pin Signal name

Shell

SG

RDB

SDA

SDB

RDA

FG

Display

Shield

External Device side
RS-422/485

Communication
Terminal block

SG

Signal name

Tx-

RX+

RX-

Tx+
Termination
resistance
120Ω 1/2W

CA4-ADPONL-01

Termination
resistance
120Ω 1/2W

Display side

User-created cable

7

3

8

5

D-sub 9 pin (plug)

2

Pin Signal name

Shell

SG

RDB

SDA

SDB

RDA

FG

Display

Shield

External Device side
RS-422/485

Communication
Terminal block

SG

Signal name

Tx-

RX+

RX-

Tx+

CA4-ADPONL-01

Termination
resistance
120Ω 1/2W

Shield

External Device side
RS-422/485

Communication
Terminal block

SG

Signal name

Tx-

RX+

RX-

Tx+
Termination
resistance
120Ω 1/2W

Display side

User-created cable
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11E)
• 1:1 Connection

• 1:n Connection

*1 The resistance in the Display is used as the termination resistance. Set the value of the DIP Switch on the 
rear of the Display as shown in the table below.  

DIP Switch No. Set Value

1 OFF

2 OFF

3 ON

4 ON

• The cable length must be 1000m or less.

Shield

External Device side
RS-422/485

Communication
Terminal block

SG

Signal name

Tx-

RX+

RX-

Tx+

Termination
resistance*1

Display

Termination
resistance
120Ω 1/2W

 Display side 
Terminal block

RDB

SDA

SDB

RDA

CSA

ERB

CSB

ERA

Signal name

SG

Shield

External Device side
RS-422/485

Communication
Terminal block

SG

Signal name

Tx-

RX+

RX-

Tx+
Termination
resistance*1

Display

Shield

External Device side
RS-422/485

Communication
Terminal block

SG

Signal name

Tx-

RX+

RX-

Tx+
Termination
resistance
120Ω 1/2W

 Display side 
Terminal block

RDB

SDA

SDB

RDA

CSA

ERB

CSB

ERA

Signal name

SG
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11F)
• 1:1 Connection

• 1:n Connection

• The cable length must be 1000m or less.

Display

PFXZCBADTM1

Shield

Terminal block

TERM

RDA

RDB

SDA

Signal name

SG

FG

SDB

External Device side
RS-422/485

Communication
Terminal block

SG

Signal name

Tx-

RX+

RX-

Tx+

Termination
resistance
120Ω 1/2W

Termination
resistance
120Ω 1/2W

Display side

User-created cable

Display

PFXZCBADTM1

Shield

Terminal block

TERM

RDA

RDB

SDA

Signal name

SG

FG

SDB

External Device side
RS-422/485

Communication
Terminal block

SG

Signal name

Tx-

RX+

RX-

Tx+

Termination
resistance
120Ω 1/2W

Shield

External Device side
RS-422/485

Communication
Terminal block

SG

Signal name

Tx-

RX+

RX-

Tx+
Termination
resistance
120Ω 1/2W

Display side

User-created cable
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11G)
• 1:1 Connection

• 1:n Connection

• The cable length must be 1000m or less.

Shield 

External Device side 
RS-422/485 

Communication 
Terminal block 

SG 

Signal name 

Tx- 

RX+ 

RX- 

Tx+ 

4

2

1

5 

7

D-sub 9 pin (socket) 

3

Pin Signal name 

Rx+

Rx-

Tx+

Tx-

GND

NC

NC

NC

NC

9 

6 

FG Shell 

8 

Termination 
resistance 
120Ω 1/2W 

Display 

Termination 
resistance 
120Ω 1/2W 

Display side 

Shield 

External Device side 
RS-422/485 

Communication 
Terminal block 

SG 

Signal name 

Tx- 

RX+ 

RX- 

Tx+ 

4

2

1

5 

7

D-sub 9 pin (socket) 

GND

3

Pin Signal name 

Rx-

Rx+

Tx-

NC

NC

NC

NC

Tx+

9 

6 

FG Shell 

8 

Termination 
resistance 
120Ω 1/2W 

Display 

Shield 

External Device side 
RS-422/485 

Communication 
Terminal block 

SG 

Signal name 

Tx- 

RX+ 

RX- 

Tx+ 
Termination 
resistance 
120Ω 1/2W 

Display side 
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5.12 Cable Diagram 12

Display
(Connection Port)

Cable Notes

GP3000*1 (COM1)
AGP-3302B (COM2)
GP-4*01TM (COM1)
GP-Rear Module (COM1)
ST3000*2 (COM2)
LT3000 (COM1)

12A

COM Port Conversion Adapter by Pro-face
CA3-ADPCOM-01

+
Terminal Block Conversion Adapter by Pro-face

CA3-ADPTRM-01
+

User-created cable

The cable 
length must be 
1000m or less.

12B User-created cable

GP3000*3 (COM2)

12C

Online Adapter by Pro-face
CA4-ADPONL-01

+
Terminal Block Conversion Adapter by Pro-face

CA3-ADPTRM-01
+

User-created cable

The cable 
length must be 
1000m or less.

12D

Online Adapter by Pro-face
CA4-ADPONL-01

+
User-created cable

IPC*4 12E

COM Port Conversion Adapter by Pro-face
CA3-ADPCOM-01

+
Terminal Block Conversion Adapter by Pro-face

CA3-ADPTRM-01
+

User-created cable

The cable 
length must be 
1000m or less.

12F User-created cable

GP-4106  (COM1)
GP-4116T (COM1) 12G User-created cable

The cable 
length must be 
1000m or less.

GP-4107  (COM1)
GP-4*03T*5 (COM2)
GP-4203T (COM1) 12H User-created cable

The cable 
length must be 
1000m or less.

GP4000*6 (COM2)
GP-4201T (COM1)
GP6000 (COM2)
SP5000*7 (COM1/2)
SP-5B00 (COM2)
ST6000*8 (COM2)
ST-6200 (COM1)
STM6000 (COM1)
STC6000 (COM1)
ET6000*9 (COM2)
PS6000 (Basic Box) 
(COM1/2)

12I

RS-422 Terminal Block Conversion Adapter by Pro-face
PFXZCBADTM1

*10

+
User-created cable

The cable 
length must be 
1000m or less.

12B User-created cable
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LT-4*01TM (COM1)
LT-Rear Module (COM1) 12J

RJ45 RS-485 Cable (5m) by Pro-face
PFXZLMCBRJR81

The cable 
length must be 
200m or less.

PE-4000B*11

PS5000*11

PS6000 (Optional 
Interface)*11

12K User-created cable
The cable 
length must be 
1000m or less.

*1  All GP3000 models except AGP-3302B

*2 Except AST-3211A and AST-3302B

*3 All GP3000 models except GP-3200 series and AGP-3302B

*4 Only the COM port which can communicate by RS-422/485 (2 wire) can be used. (Except PE-4000B, PS5000,
and PS6000)
 IPC COM Port (page 8)

*5 Except GP-4203T

*6 All GP4000 models except GP-4100 series, GP-4*01TM, GP-Rear Module, GP-4201T and GP-4*03T

*7 Except SP-5B00

*8 Except ST-6200

*9 Due to the COM port specifications, flow control is not possible. Omit wiring the control pins on the Display
side of the cable diagram.

*10 When using a Terminal Block Conversion Adapter (CA3-ADPTRM-01) instead of the RS-422 Terminal Block
Conversion Adapter, refer to Cable Diagram 12A.

*11 Only the COM port which can communicate by RS-422/485 (2 wire) can be used.
 IPC COM Port (page 8)

Display
(Connection Port)

Cable Notes
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12A)
• 1:1 Connection

• 1:n Connection

• The cable length must be 1000m or less.

Display

CA3-ADPTRM-01

CA3-ADPCOM-01

Shield

Terminal block

TERM

RDA

RDB

SDA

Signal name

SG

FG

SDB

External Device side
RS-422/485

Communication
Terminal block

SG

Signal name

Tx-

RX+

RX-

Tx+

Termination
resistance
120Ω 1/2W

Termination
resistance
120Ω 1/2W

Display side

User-created cable

Display

CA3-ADPTRM-01

CA3-ADPCOM-01

Shield

Terminal block

TERM

RDA

RDB

SDA

Signal name

SG

FG

SDB

External Device side
RS-422/485

Communication
Terminal block

SG

Signal name

Tx-

RX+

RX-

Tx+

Termination
resistance
120Ω 1/2W

Shield

External Device side
RS-422/485

Communication
Terminal block

SG

Signal name

Tx-

RX+

RX-

Tx+
Termination
resistance
120Ω 1/2W

Display side

User-created cable
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12B)
• 1:1 Connection

• 1:n Connection

• The cable length must be 1000m or less.

Shield

External Device side
RS-422/485

Communication
Terminal block

SG

Signal name

Tx-

RX+

RX-

Tx+

2

3

7

5

4

D-sub 9 pin (socket)

SG

1

Pin Signal name

RDB

SDA

SDB

RDA

9

6

CSA

ERB

CSB

FG

ERA

Shell

8

Termination
resistance
120Ω 1/2W

Display

Termination
resistance
120Ω 1/2W

Display side

Shield

External Device side
RS-422/485

Communication
Terminal block

SG

Signal name

Tx-

RX+

RX-

Tx+

2

3

7

5

4

D-sub 9 pin (socket)

SG

1

Pin Signal name

RDB

SDA

SDB

RDA

9

6

CSA

ERB

CSB

FG

ERA

Shell

8

Termination
resistance
120Ω 1/2W

Display

Shield

External Device side
RS-422/485

Communication
Terminal block

SG

Signal name

Tx-

RX+

RX-

Tx+
Termination
resistance
120Ω 1/2W

Display side
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12C)
• 1:1 Connection

• 1:n Connection

• The cable length must be 1000m or less.

Display

CA3-ADPTRM-01

CA4-ADPONL-01

Shield

Terminal block

TERM

RDA

RDB

SDA

Signal name

SG

FG

SDB

External Device side
RS-422/485

Communication
Terminal block

SG

Signal name

Tx-

RX+

RX-

Tx+

Termination
resistance
120Ω 1/2W

Termination
resistance
120Ω 1/2W

Display side

User-created cable

Display

CA3-ADPTRM-01

CA4-ADPONL-01

Shield

Terminal block

TERM

RDA

RDB

SDA

Signal name

SG

FG

SDB

External Device side
RS-422/485

Communication
Terminal block

SG

Signal name

Tx-

RX+

RX-

Tx+

Termination
resistance
120Ω 1/2W

Shield

External Device side
RS-422/485

Communication
Terminal block

SG

Signal name

Tx-

RX+

RX-

Tx+
Termination
resistance
120Ω 1/2W

Display side

User-created cable
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12D)
• 1:1 Connection

• 1:n Connection

• The cable length must be 1000m or less.

7

3

8

5

D-sub 9 pin (plug)

2

Pin Signal name

Shell

SG

RDB

SDA

SDB

RDA

FG

Display

Shield

External Device side
RS-422/485

Communication
Terminal block

SG

Signal name

Tx-

RX+

RX-

Tx+
Termination
resistance
120Ω 1/2W

CA4-ADPONL-01

Termination
resistance
120Ω 1/2W

Display side

User-created cable

7

3

8

5

D-sub 9 pin (plug)

2

Pin Signal name

Shell

SG

RDB

SDA

SDB

RDA

FG

Display

Shield

External Device side
RS-422/485

Communication
Terminal block

SG

Signal name

Tx-

RX+

RX-

Tx+

CA4-ADPONL-01

Termination
resistance
120Ω 1/2W

Shield

External Device side
RS-422/485

Communication
Terminal block

SG

Signal name

Tx-

RX+

RX-

Tx+
Termination
resistance
120Ω 1/2W

Display side

User-created cable
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12E)
• 1:1 Connection

• 1:n Connection

• The cable length must be 1000m or less.

Display

CA3-ADPTRM-01

CA3-ADPCOM-01

Shield

Terminal block

TERM

RDA

RDB

SDA

Signal name

SG

FG

SDB

External Device side
RS-422/485

Communication
Terminal block

SG

Signal name

Tx-

RX+

RX-

Tx+

Termination
resistance
120Ω 1/2W

Termination
resistance
120Ω 1/2W

Display side

User-created cable

Display

CA3-ADPTRM-01

CA3-ADPCOM-01

Shield

Terminal block

TERM

RDA

RDB

SDA

Signal name

SG

FG

SDB

External Device side
RS-422/485

Communication
Terminal block

SG

Signal name

Tx-

RX+

RX-

Tx+

Termination
resistance
120Ω 1/2W

Shield

External Device side
RS-422/485

Communication
Terminal block

SG

Signal name

Tx-

RX+

RX-

Tx+

Termination
resistance
120Ω 1/2W

Display side

User-created cable
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12F)
• 1:1 Connection

• 1:n Connection

• The cable length must be 1000m or less.

Shield

External Device side
RS-422/485

Communication
Terminal block

SG

Signal name

Tx-

RX+

RX-

Tx+

2

3

7

5

4

D-sub 9 pin (socket)

GND(SG)

1

Pin Signal name

DATA-

NC

NC

DATA+

9

6

CSA

ERB

CSB

FG

ERA

Shell

8

Termination
resistance
120Ω 1/2W

Display

Termination
resistance
120Ω 1/2W

Display side

Shield

External Device side
RS-422/485

Communication
Terminal block

SG

Signal name

Tx-

RX+

RX-

Tx+

2

3

7

5

4

D-sub 9 pin (socket)

GND(SG)

1

Pin Signal name

DATA-

NC

NC

DATA+

9

6

CSA

ERB

CSB

FG

ERA

Shell

8

Termination
resistance
120Ω 1/2W

Display

Shield

External Device side
RS-422/485

Communication
Terminal block

SG

Signal name

Tx-

RX+

RX-

Tx+

Termination
resistance
120Ω 1/2W

Display side
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12G)
• 1:1 Connection

• 1:n Connection

*1 The resistance in the Display is used as the termination resistance. Set the value of the DIP Switch on the 
rear of the Display as shown in the table below.     

DIP Switch No. Set Value

1 OFF

2 OFF

3 ON

4 ON

• The cable length must be 1000m or less.

Shield

External Device side
RS-422/485

Communication
Terminal block

SG

Signal name

Tx-

RX+

RX-

Tx+
Termination
resistance*1

Display

Termination
resistance
120Ω 1/2W

 Display side 
Terminal block

RDB

SDA

SDB

RDA

CSA

ERB

CSB

ERA

Signal name

SG

Shield

External Device side
RS-422/485

Communication
Terminal block

SG

Signal name

Tx-

RX+

RX-

Tx+
Termination
resistance*1

Display

Shield

External Device side
RS-422/485

Communication
Terminal block

SG

Signal name

Tx-

RX+

RX-

Tx+
Termination
resistance
120Ω 1/2W

 Display side 
Terminal block

RDB

SDA

SDB

RDA

CSA

ERB

CSB

ERA

Signal name

SG
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12H)
• 1:1 Connection

• 1:n Connection

• The 5V output (Pin #6) on the Display is the power for the Siemens AG’s PROFIBUS 
connector. Do not use it for other devices.

• In COM on the GP-4107, the SG and FG terminals are isolated.
• The cable length must be 1000m or less.

Shield

External Device side
RS-422/485

Communication
Terminal block

SG

Signal name

Tx-

RX+

RX-

Tx+

Termination
resistance
120Ω 1/2W

Display

Termination
resistance
120Ω 1/2W

Pin Signal name

Display side
D-sub 9 pin (plug)

3

8

1

2

5

4

6

7

9

Shell

NC

NC

GND(SG)

RS(RTS)

5V

NC

NC

FG

LINE(+)

LINE(-)

Shield

External Device side
RS-422/485

Communication
Terminal block

SG

Signal name

Tx-

RX+

RX-

Tx+

Pin Signal nameTermination
resistance
120Ω 1/2W

Display

Shield

External Device side
RS-422/485

Communication
Terminal block

SG

Signal name

Tx-

RX+

RX-

Tx+

Termination
resistance
120Ω 1/2W

Display side
D-sub 9 pin (plug)

3

8

1

2

5

4

6

7

9

Shell

NC

NC

GND(SG)

RS(RTS)

5V

NC

NC

FG

LINE(+)

LINE(-)
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12I)
• 1:1 Connection

• 1:n Connection

• The cable length must be 1000m or less.

Display

PFXZCBADTM1

Shield

Terminal block

TERM

RDA

RDB

SDA

Signal name

SG

FG

SDB

External Device side
RS-422/485

Communication
Terminal block

SG

Signal name

Tx-

RX+

RX-

Tx+

Termination
resistance
120Ω 1/2W

Termination
resistance
120Ω 1/2W

Display side

User-created cable

Display

PFXZCBADTM1

Shield

Terminal block

TERM

RDA

RDB

SDA

Signal name

SG

FG

SDB

External Device side
RS-422/485

Communication
Terminal block

SG

Signal name

Tx-

RX+

RX-

Tx+

Termination
resistance
120Ω 1/2W

Shield

External Device side
RS-422/485

Communication
Terminal block

SG

Signal name

Tx-

RX+

RX-

Tx+
Termination
resistance
120Ω 1/2W

Display side

User-created cable
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12J)
• 1:1 Connection

• 1:n Connection

• The cable length must be 200m or less.

External Device side
RS-422/485

Communication
Terminal block

SG

Signal name

Tx-

RX+

RX-

Tx+

Termination
resistance
120Ω 1/2W

Display
D1

D0

PFXZLMCBRJR81

GND

External Device side
RS-422/485

Communication
Terminal block

SG

Signal name

Tx-

RX+

RX-

Tx+

Shield

External Device side
RS-422/485

Communication
Terminal block

SG

Signal name

Tx-

RX+

RX-

Tx+

Termination
resistance
220Ω 1/2WDisplay D1

D0

PFXZLMCBRJR81

GND

Termination
resistance
220Ω 1/2W
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12K)
• 1:1 Connection

• 1:n Connection

• The cable length must be 1000m or less.

Shield 

External Device side 
RS-422/485 

Communication 
Terminal block 

SG 

Signal name 

Tx- 

RX+ 

RX- 

Tx+ 

1

3 

7 

5 

4 

D-sub 9 pin (socket) 

GND

2

Pin Signal name 

DATA- 

NC 

NC 

NC

NC

NC

NC

DATA+ 

9 

6 

FG Shell 

8 

Termination 
resistance 
120Ω 1/2W 

Display 

Termination 
resistance 
120Ω 1/2W 

Display side 

Shield 

External Device side 
RS-422/485 

Communication 
Terminal block 

SG 

Signal name 

Tx- 

RX+ 

RX- 

Tx+ 

1

3 

7 

5 

4 

D-sub 9 pin (socket) 

GND

2

Pin Signal name 

DATA- 

NC 

NC 

NC

NC

NC

NC

DATA+ 

9 

6 

FG Shell 

8 

Termination 
resistance 
120Ω 1/2W 

Display 

Shield 

External Device side 
RS-422/485 

Communication 
Terminal block 

SG 

Signal name 

Tx- 

RX+ 

RX- 

Tx+ 

Termination 
resistance 
120Ω 1/2W 

Display side 
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5.13 Cable Diagram 13

13A)

Display
(Connection Port)

Cable Notes

GP3000 (COM1)
GP4000*1 (COM1)
GP6000 (COM1)
SP5000*2 (COM1/2)
SP-5B00 (COM1)
ST3000 (COM1)
ST6000 (COM1)
STM6000 (COM1)
STC6000 (COM1)
ET6000 (COM1)
LT3000 (COM1)
IPC*3

PC/AT

*1 All GP4000 models except GP-4100 series and GP-4203T

*2 Except SP-5B00

*3 Only the COM port which can communicate by RS-232C can be used.
 IPC COM Port (page 8)

13A User-created cable The cable length must be 3m 
or less.

GP-4105  (COM1)
GP-4115T (COM1)
GP-4115T3 (COM1) 13B User-created cable The cable length must be 3m 

or less.

LT-4*01TM (COM1)
LT-Rear Module (COM1) 13C

RJ45 RS-232C Cable (5m) by Pro-face
PFXZLMCBRJR21 The cable length must be 3m 

or less.

Shield

2

8

7

5

4

3

Pin Signal name

Shell

6

2

3

6

8

Display side
D-sub 9 pin (socket)

External Device side
RJ45 (plug)

SG

1

Pin Signal name

SD(TXD)

RS(RTS)

CS(CTS)

RD(RXD)

Display

User-created cable

SG

RD(RXD)

CS(CTS)

RS(RTS)

SD(TXD)

DR(DSR)

ER(DTR)

FG
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13B)

13C)

No. Name Notes

(1)
RJ45 RS-232C Cable (5m) by Pro-face

PFXZLMCBRJR21

• When using this connection, in the RS-232C communication settings set the 
[Flow Control] to [None].

Shield

Signal name

2

3

6

8

Display side
Terminal block

External Device side
RJ45 (plug)

SG

1

Pin Signal name

SD(TXD)

RS(RTS)

CS(CTS)

RD(RXD)

Display

User-created cable

SG

RD(RXD)

CS(CTS)

RS(RTS)

SD(TXD)

DR(DSR)

ER(DTR)

2

3

6

8

External Device side
RJ45 (plug)

SG

1

Pin Signal name

SD(TXD)

RS(RTS)

CS(CTS)

RD(RXD)
Display

GND

RXD

TXD

(1)
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5.14 Cable Diagram 14

Display
(Connection Port)

Cable Notes

GP3000*1 (COM1)
AGP-3302B (COM2)
GP-4*01TM (COM1)
GP-Rear Module 
(COM1)
ST3000*2 (COM2)
LT3000 (COM1)

14A

COM Port Conversion Adapter by Pro-face
CA3-ADPCOM-01

+
Terminal Block Conversion Adapter by Pro-face

CA3-ADPTRM-01
+

User-created cable

The cable length 
must be 15m or 
less.

14B User-created cable

GP3000*3 (COM2)

14C

Online Adapter by Pro-face
CA4-ADPONL-01

+
Terminal Block Conversion Adapter by Pro-face

CA3-ADPTRM-01
+

User-created cable

The cable length 
must be 15m or 
less.

14D

Online Adapter by Pro-face
CA4-ADPONL-01

+
User-created cable

IPC*4 14E

COM Port Conversion Adapter by Pro-face
CA3-ADPCOM-01

+
Terminal Block Conversion Adapter by Pro-face

CA3-ADPTRM-01
+

User-created cable

The cable length 
must be 15m or 
less.

14F User-created cable

GP-4106  (COM1)
GP-4116T (COM1) 14G User-created cable

The cable length 
must be 15m or 
less.

GP-4107  (COM1)
GP-4*03T*5 (COM2)
GP-4203T (COM1) 14H User-created cable

The cable length 
must be 15m or 
less.

GP4000*6 (COM2)
GP-4201T (COM1)
GP6000 (COM2)
SP5000*7 (COM1/2)
SP-5B00 (COM2)
ST6000*8 (COM2)
ST-6200 (COM1)
STM6000 (COM1)
STC6000 (COM1)
ET6000*9 (COM2)
PS6000 (Basic Box) 
(COM1/2)

14I

RS-422 Terminal Block Conversion Adapter by Pro-face
PFXZCBADTM1

*10

+
User-created cable

The cable length 
must be 15m or 
less.

14B User-created cable
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LT-4*01TM (COM1)
LT-Rear Module 
(COM1) 14J

RJ45 RS-485 Cable (5m) by Pro-face
PFXZLMCBRJR81

The cable length 
must be 15m or 
less.

PE-4000B*11

PS5000*11

PS6000 (Optional 
Interface)*11

14K User-created cable
The cable length 
must be 15m or 
less.

*1  All GP3000 models except AGP-3302B

*2 Except AST-3211A and AST-3302B

*3 All GP3000 models except GP-3200 series and AGP-3302B

*4 Only the COM port which can communicate by RS-422/485 (2 wire) can be used. (Except PE-4000B, PS5000,
and PS6000)
 IPC COM Port (page 8)

*5 Except GP-4203T

*6 All GP4000 models except GP-4100 series, GP-4*01TM, GP-Rear Module, GP-4201T and GP-4*03T

*7 Except SP-5B00

*8 Except ST-6200

*9 Due to the COM port specifications, flow control is not possible. Omit wiring the control pins on the Display
side of the cable diagram.

*10 When using a Terminal Block Conversion Adapter (CA3-ADPTRM-01) instead of the RS-422 Terminal Block
Conversion Adapter, refer to Cable Diagram 14A.

*11 Only the COM port which can communicate by RS-422/485 (2 wire) can be used.
 IPC COM Port (page 8)

Display
(Connection Port)

Cable Notes
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14A)
• 1:1 Connection

• 1:n Connection

• Do not connect the cable to the 5 Vdc pin on the External Device.

Display

CA3-ADPTRM-01

CA3-ADPCOM-01

Shield

Display side
Terminal block

RDA

RDB

SDA

SDB

Signal name

SG

FG

TERMRX

User-created cable

5

7

8

External Device side
RJ45 (plug)

4

Pin Signal name

D0

5Vdc

SG

D1

Display

CA3-ADPTRM-01

CA3-ADPCOM-01

Shield

Display side
Terminal block

RDA

RDB

SDA

SDB

Signal name

SG

FG

TERMRX

User-created cable

5

7

8

External Device side
RJ45 (plug)

4

Pin Signal name

D0

5Vdc

SG

D1

Shield

5

7

8

External Device side
RJ45 (plug)

4

Pin Signal name

D0

5Vdc

SG

D1
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14B)
• 1:1 Connection

• 1:n Connection

• Do not connect the cable to the 5 Vdc pin on the External Device.

Display

Shield

Display side
D-sub 9 pin (socket)

RDA

RDB

SDA

SDB

Signal name

SG

ERA

CSA

ERB

CSB

FG

1

2

3

7

Pin

5

4

8

9

6

Shell

5

7

8

External Device side
RJ45 (plug)

4

Pin Signal name

D0

5Vdc

SG

D1

Display

Shield

Display side
D-sub 9 pin (socket)

RDA

RDB

SDA

SDB

Signal name

SG

ERA

CSA

ERB

CSB

FG

1

2

3

7

Pin

5

4

8

9

6

Shell

5

7

8

External Device side
RJ45 (plug)

4

Pin Signal name

D0

5Vdc

SG

D1

Shield

5

7

8

External Device side
RJ45 (plug)

4

Pin Signal name

D0

5Vdc

SG

D1
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14C)
• 1:1 Connection

• 1:n Connection

• Do not connect the cable to the 5 Vdc pin on the External Device.

Display

CA3-ADPTRM-01

CA4-ADPONL-01

Shield

Display side
Terminal block

RDA

RDB

SDA

SDB

Signal name

SG

FG

TERMRX

User-created cable

5

7

8

External Device side
RJ45 (plug)

4

Pin Signal name

D0

5Vdc

SG

D1

Display

CA3-ADPTRM-01

CA4-ADPONL-01

Shield

Display side
Terminal block

RDA

RDB

SDA

SDB

Signal name

SG

FG

TERMRX

User-created cable

5

7

8

External Device side
RJ45 (plug)

4

Pin Signal name

D0

5Vdc

SG

D1

Shield

5

7

8

External Device side
RJ45 (plug)

4

Pin Signal name

D0

5Vdc

SG

D1
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14D)
• 1:1 Connection

• 1:n Connection

• Do not connect the cable to the 5 Vdc pin on the External Device.

Display

Shield

Display side
D-sub 9 pin (plug)

TERMRX

RDA

RDB

SDA

Signal name

SDB

TERMTX

SG

FG

1

2

7

3

Pin

8

9

5

Shell

5

7

8

External Device side
RJ45 (plug)

4

Pin Signal name

D0

5Vdc

SG

D1

CA4-ADPONL-01

User-created cable

Display

Shield

Display side
D-sub 25 pin (plug)

TERMRX

RDA

RDB

SDA

Signal name

SDB

TERMTX

SG

FG

1

2

7

3

Pin

8

9

5

Shell

5

7

8

External Device side
RJ45 (plug)

4

Pin Signal name

D0

5Vdc

SG

D1

Shield

5

7

8

External Device side
RJ45 (plug)

4

Pin Signal name

D0

5Vdc

SG

D1

CA4-ADPONL-01

User-created cable
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14E)
• 1:1 Connection

• 1:n Connection

• Do not connect the cable to the 5 Vdc pin on the External Device.

Display

CA3-ADPTRM-01

CA3-ADPCOM-01

Shield

Display side
Terminal block

RDA

RDB

SDA

SDB

Signal name

SG

FG

TERMRX

User-created cable

5

7

8

External Device side
RJ45 (plug)

4

Pin Signal name

D0

5Vdc

SG

D1

Display

CA3-ADPTRM-01

CA3-ADPCOM-01

Shield

Display side
Terminal block

RDA

RDB

SDA

SDB

Signal name

SG

FG

TERMRX

User-created cable

5

7

8

External Device side
RJ45 (plug)

4

Pin Signal name

D0

5Vdc

SG

D1

Shield

5

7

8

External Device side
RJ45 (plug)

4

Pin Signal name

D0

5Vdc

SG

D1
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14F)
• 1:1 Connection

• 1:n Connection

• Do not connect the cable to the 5 Vdc pin on the External Device.

Display

Shield

Display side
D-sub 9 pin (socket)

DATA+

DATA-

NC

NC

Signal name

SG

ERA

CSA

ERB

CSB

FG

1

2

3

7

Pin

5

4

8

9

6

Shell

5

7

8

External Device side
RJ45 (plug)

4

Pin Signal name

D0

5Vdc

SG

D1

Display

Shield

Display side
D-sub 9 pin (socket)

DATA+

DATA-

NC

NC

Signal name

SG

ERA

CSA

ERB

CSB

FG

1

2

3

7

Pin

5

4

8

9

6

Shell

5

7

8

External Device side
RJ45 (plug)

4

Pin Signal name

D0

5Vdc

SG

D1

Shield

5

7

8

External Device side
RJ45 (plug)

4

Pin Signal name

D0

5Vdc

SG

D1
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14G)
• 1:1 Connection

• 1:n Connection

• Do not connect the cable to the 5 Vdc pin on the External Device.

Display

Shield

Display side
Terminal block

RDA

RDB

SDA

SDB

Signal name

SG

ERA

CSA

ERB

CSB

5

7

8

External Device side
RJ45 (plug)

4

Pin Signal name

D0

5Vdc

SG

D1

Display

Shield

Display side
Terminal block

RDA

RDB

SDA

SDB

Signal name

SG

ERA

CSA

ERB

CSB

5

7

8

External Device side
RJ45 (plug)

4

Pin Signal name

D0

5Vdc

SG

D1

Shield

5

7

8

External Device side
RJ45 (plug)

4

Pin Signal name

D0

5Vdc

SG

D1
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14H)
• 1:1 Connection

• 1:n Connection

• The 5V output (Pin #6) on the Display is the power for the Siemens AG’s PROFIBUS 
connector. Do not use it for other devices.

• Do not connect the cable to the 5 Vdc pin on the External Device.

• In COM on the GP-4107, the SG and FG terminals are isolated.

Display

Shield

Display side
D-sub 9 pin (socket)

LINE+

LINE-

NC

NC

Signal name

SG

RS

5V

NC

NC

FG

3

8

1

2

Pin

5

4

6

7

9

Shell

5

7

8

External Device side
RJ45 (plug)

4

Pin Signal name

D0

5Vdc

SG

D1

Display

Shield

Display side
D-sub 9 pin (socket)

LINE+

LINE-

NC

NC

Signal name

SG

RS

5V

NC

NC

FG

3

8

1

2

Pin

5

4

6

7

9

Shell

5

7

8

External Device side
RJ45 (plug)

4

Pin Signal name

D0

5Vdc

SG

D1

Shield

5

7

8

External Device side
RJ45 (plug)

4

Pin Signal name

D0

5Vdc

SG

D1
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14I)
• 1:1 Connection

• 1:n Connection

• Do not connect the cable to the 5 Vdc pin on the External Device.

Display

PFXZCBADTM1

Shield

Display side
Terminal block

RDA

RDB

SDA

SDB

Signal name

SG

FG

TERMRX

User-created cable

5

7

8

External Device side
RJ45 (plug)

4

Pin Signal name

D0

5Vdc

SG

D1

Display

PFXZCBADTM1

Shield

Display side
Terminal block

RDA

RDB

SDA

SDB

Signal name

SG

FG

TERMRX

User-created cable

5

7

8

External Device side
RJ45 (plug)

4

Pin Signal name

D0

5Vdc

SG

D1

Shield

5

7

8

External Device side
RJ45 (plug)

4

Pin Signal name

D0

5Vdc

SG

D1
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14J)
• 1:1 Connection

• 1:n Connection

No. Name Notes

(1)
RJ45 RS-485 Cable (5m) by Pro-face

PFXZLMCBRJR81

• Do not connect the cable to the 5 Vdc pin on the External Device.

Display

GND

D0

D1

(1)
5

7

8

External Device side
RJ45 (plug)

4

Pin Signal name

D0

5Vdc

SG

D1

Display

GND

D0

D1

(1)
5

7

8

External Device side
RJ45 (plug)

4

Pin Signal name

D0

5Vdc

SG

D1

Shield

5

7

8

External Device side
RJ45 (plug)

4

Pin Signal name

D0

5Vdc

SG

D1
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14K)
• 1:1 Connection

• 1:n Connection

• Do not connect the cable to the 5 Vdc pin on the External Device.

Display

Shield

Display side
D-sub 9 pin (socket)

DATA+

DATA-

NC

NC

Signal name

GND

NC

NC

NC

NC

FG

2

1

3

7

Pin

5

4

8

9

6

Shell

5

7

8

External Device side
RJ45 (plug)

4

Pin Signal name

D0

5Vdc

SG

D1

Display

Shield

Display side
D-sub 9 pin (socket)

DATA+

DATA-

NC

NC

Signal name

GND

NC

NC

NC

NC

FG

2

1

3

7

Pin

5

4

8

9

6

Shell

5

7

8

External Device side
RJ45 (plug)

4

Pin Signal name

D0

5Vdc

SG

D1

Shield

5

7

8

External Device side
RJ45 (plug)

4

Pin Signal name

D0

5Vdc

SG

D1



MODBUS SIO Master Driver

GP-Pro EX Device/PLC Connection Manual 157

5.15 Cable Diagram 15

Display
(Connection Port)

Cable Notes

GP3000*1 (COM1)
AGP-3302B (COM2)
GP-4*01TM (COM1)
GP-Rear Module 
(COM1)
ST3000*2 (COM2)
LT3000 (COM1)

15A

COM Port Conversion Adapter by Pro-face
CA3-ADPCOM-01

+
Terminal Block Conversion Adapter by Pro-face

CA3-ADPTRM-01
+

User-created cable

The cable length 
must be 15m or 
less.

15B User-created cable

GP3000*3 (COM2)

15C

Online Adapter by Pro-face
CA4-ADPONL-01

+
Terminal Block Conversion Adapter by Pro-face

CA3-ADPTRM-01
+

User-created cable

The cable length 
must be 15m or 
less.

15D

Online Adapter by Pro-face
CA4-ADPONL-01

+
User-created cable

IPC*4 15E

COM Port Conversion Adapter by Pro-face
CA3-ADPCOM-01

+
Terminal Block Conversion Adapter by Pro-face

CA3-ADPTRM-01
+

User-created cable

The cable length 
must be 15m or 
less.

15F User-created cable

GP-4106  (COM1)
GP-4116T (COM1) 15G User-created cable

The cable length 
must be 15m or 
less.

GP-4107  (COM1)
GP-4*03T*5 (COM2)
GP-4203T (COM1) 15H User-created cable

The cable length 
must be 15m or 
less.

GP4000*6 (COM2)
GP-4201T (COM1)
GP6000 (COM2)
SP5000*7 (COM1/2)
SP-5B00 (COM2)
ST6000*8 (COM2)
ST-6200 (COM1)
STM6000 (COM1)
STC6000 (COM1)
ET6000*9 (COM2)
PS6000 (Basic Box) 
(COM1/2)

15I

RS-422 Terminal Block Conversion Adapter by Pro-face
PFXZCBADTM1

*10

+
User-created cable

The cable length 
must be 15m or 
less.

15B User-created cable
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LT-4*01TM (COM1)
LT-Rear Module 
(COM1) 15J

RJ45 RS-485 Cable (5m) by Pro-face
PFXZLMCBRJR81

The cable length 
must be 15m or 
less.

PE-4000B*11

PS5000*11

PS6000 (Optional 
Interface)*11

15K User-created cable
The cable length 
must be 15m or 
less.

*1  All GP3000 models except AGP-3302B

*2 Except AST-3211A and AST-3302B

*3 All GP3000 models except GP-3200 series and AGP-3302B

*4 Only the COM port which can communicate by RS-422/485 (2 wire) can be used. (Except PE-4000B, PS5000,
and PS6000)
 IPC COM Port (page 8)

*5 Except GP-4203T

*6 All GP4000 models except GP-4100 series, GP-4*01TM, GP-Rear Module, GP-4201T and GP-4*03T

*7 Except SP-5B00

*8 Except ST-6200

*9 Due to the COM port specifications, flow control is not possible. Omit wiring the control pins on the Display
side of the cable diagram.

*10 When using a Terminal Block Conversion Adapter (CA3-ADPTRM-01) instead of the RS-422 Terminal Block
Conversion Adapter, refer to Cable Diagram 15A.

*11 Only the COM port which can communicate by RS-422/485 (2 wire) can be used.
 IPC COM Port (page 8)

Display
(Connection Port)

Cable Notes
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15A)
• 1:1 Connection

• 1:n Connection

Display

CA3-ADPTRM-01

CA3-ADPCOM-01

Shield

Display side
Terminal block

RDA

RDB

SDA

SDB

Signal name

SG

FG

TERMRX

User-created cable

5

7

8

External Device side
RJ45 (plug)

4

Pin Signal name

D0

NC

SG

D1

Display

CA3-ADPTRM-01

CA3-ADPCOM-01

Shield

Display side
Terminal block

RDA

RDB

SDA

SDB

Signal name

SG

FG

TERMRX

User-created cable

5

7

8

External Device side
RJ45 (plug)

4

Pin Signal name

D0

NC

SG

D1

Shield

5

7

8

External Device side
RJ45 (plug)

4

Pin Signal name

D0

NC

SG

D1
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15B)
• 1:1 Connection

• 1:n Connection

Display

Shield

Display side
D-sub 9 pin (socket)

RDA

RDB

SDA

SDB

Signal name

SG

ERA

CSA

ERB

CSB

FG

1

2

3

7

Pin

5

4

8

9

6

Shell

5

7

8

External Device side
RJ45 (plug)

4

Pin Signal name

D0

NC

SG

D1

Display

Shield

Display side
D-sub 9 pin (socket)

RDA

RDB

SDA

SDB

Signal name

SG

ERA

CSA

ERB

CSB

FG

1

2

3

7

Pin

5

4

8

9

6

Shell

5

7

8

External Device side
RJ45 (plug)

4

Pin Signal name

D0

NC

SG

D1

Shield

5

7

8

External Device side
RJ45 (plug)

4

Pin Signal name

D0

NC

SG

D1
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15C)
• 1:1 Connection

• 1:n Connection

Display

CA3-ADPTRM-01

CA4-ADPONL-01

Shield

Display side
Terminal block

RDA

RDB

SDA

SDB

Signal name

SG

FG

TERMRX

User-created cable

5

7

8

External Device side
RJ45 (plug)

4

Pin Signal name

D0

NC

SG

D1

Display

CA3-ADPTRM-01

CA4-ADPONL-01

Shield

Display side
Terminal block

RDA

RDB

SDA

SDB

Signal name

SG

FG

TERMRX

User-created cable

5

7

8

External Device side
RJ45 (plug)

4

Pin Signal name

D0

NC

SG

D1

Shield

5

7

8

External Device side
RJ45 (plug)

4

Pin Signal name

D0

NC

SG

D1
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15D)
• 1:1 Connection

• 1:n Connection

Display

Shield

Display side
D-sub 9 pin (socket)

TERMRX

RDA

RDB

SDA

Signal name

SDB

TERMTX

SG

FG

1

2

7

3

Pin

8

9

5

Shell

5

7

8

External Device side
RJ45 (plug)

4

Pin Signal name

D0

NC

SG

D1

CA4-ADPONL-01

User-created cable

Display

Shield

Display side
D-sub 9 pin (socket)

TERMRX

RDA

RDB

SDA

Signal name

SDB

TERMTX

SG

FG

1

2

7

3

Pin

8

9

5

Shell

5

7

8

External Device side
RJ45 (plug)

4

Pin Signal name

D0

NC

SG

D1

Shield

5

7

8

External Device side
RJ45 (plug)

4

Pin Signal name

D0

NC

SG

D1

CA4-ADPONL-01

User-created cable
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15E)
• 1:1 Connection

• 1:n Connection

Display

CA3-ADPTRM-01

CA3-ADPCOM-01

Shield

Display side
Terminal block

RDA

RDB

SDA

SDB

Signal name

SG

FG

TERMRX

User-created cable

5

7

8

External Device side
RJ45 (plug)

4

Pin Signal name

D0

NC

SG

D1

Display

CA3-ADPTRM-01

CA3-ADPCOM-01

Shield

Display side
Terminal block

RDA

RDB

SDA

SDB

Signal name

SG

FG

TERMRX

User-created cable

5

7

8

External Device side
RJ45 (plug)

4

Pin Signal name

D0

NC

SG

D1

Shield

5

7

8

External Device side
RJ45 (plug)

4

Pin Signal name

D0

NC

SG

D1
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15F)
• 1:1 Connection

• 1:n Connection

Display

Shield

Display side
D-sub 9 pin (socket)

DATA+

DATA-

NC

NC

Signal name

SG

ERA

CSA

ERB

CSB

FG

1

2

3

7

Pin

5

4

8

9

6

Shell

5

7

8

External Device side
RJ45 (plug)

4

Pin Signal name

D0

NC

SG

D1

Display

Shield

Display side
D-sub 9 pin (socket)

DATA+

DATA-

NC

NC

Signal name

SG

ERA

CSA

ERB

CSB

FG

1

2

3

7

Pin

5

4

8

9

6

Shell

5

7

8

External Device side
RJ45 (plug)

4

Pin Signal name

D0

NC

SG

D1

Shield

5

7

8

External Device side
RJ45 (plug)

4

Pin Signal name

D0

NC

SG

D1
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15G)
• 1:1 Connection

• 1:n Connection

Display

Shield

Display side
Terminal block

RDA

RDB

SDA

SDB

Signal name

SG

ERA

CSA

ERB

CSB

5

7

8

External Device side
RJ45 (plug)

4

Pin Signal name

D0

NC

SG

D1

Display

Shield

Display side
Terminal block

RDA

RDB

SDA

SDB

Signal name

SG

ERA

CSA

ERB

CSB

5

7

8

External Device side
RJ45 (plug)

4

Pin Signal name

D0

NC

SG

D1

Shield

5

7

8

External Device side
RJ45 (plug)

4

Pin Signal name

D0

NC

SG

D1
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15H)
• 1:1 Connection

• 1:n Connection

• The 5V output (Pin #6) on the Display is the power for the Siemens AG’s PROFIBUS 
connector. Do not use it for other devices.

• In COM on the GP-4107, the SG and FG terminals are isolated.

Display

Shield

Display side
D-sub 9 pin (socket)

LINE+

LINE-

NC

NC

Signal name

SG

RS

5V

NC

NC

FG

3

8

1

2

Pin

5

4

6

7

9

Shell

5

7

8

External Device side
RJ45 (plug)

4

Pin Signal name

D0

NC

SG

D1

Display

Shield

Display side
D-sub 9 pin (socket)

LINE+

LINE-

NC

NC

Signal name

SG

RS

5V

NC

NC

FG

3

8

1

2

Pin

5

4

6

7

9

Shell

5

7

8

External Device side
RJ45 (plug)

4

Pin Signal name

D0

NC

SG

D1

Shield

5

7

8

External Device side
RJ45 (plug)

4

Pin Signal name

D0

NC

SG

D1
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15I)
• 1:1 Connection

• 1:n Connection

Display

PFXZCBADTM1

Shield

Display side
Terminal block

RDA

RDB

SDA

SDB

Signal name

SG

FG

TERMRX

User-created cable

5

7

8

External Device side
RJ45 (plug)

4

Pin Signal name

D0

NC

SG

D1

Display

PFXZCBADTM1

Shield

Display side
Terminal block

RDA

RDB

SDA

SDB

Signal name

SG

FG

TERMRX

User-created cable

5

7

8

External Device side
RJ45 (plug)

4

Pin Signal name

D0

NC

SG

D1

Shield

5

7

8

External Device side
RJ45 (plug)

4

Pin Signal name

D0

NC

SG

D1
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15J)
• 1:1 Connection

• 1:n Connection

No. Name Notes

(1)
RJ45 RS-485 Cable (5m) by Pro-face

PFXZLMCBRJR81

Display

GND

D0

D1

(1)
5

7

8

External Device side
RJ45 (plug)

4

Pin Signal name

D0

NC

SG

D1

Display

GND

D0

D1

(1)
5

7

8

External Device side
RJ45 (plug)

4

Pin Signal name

D0

NC

SG

D1

Shield

5

7

8

External Device side
RJ45 (plug)

4

Pin Signal name

D0

NC

SG

D1
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15K)
• 1:1 Connection

• 1:n Connection

Display

Shield

Display side
D-sub 9 pin (socket)

DATA+

DATA-

NC

NC

Signal name

GND

NC

NC

NC

NC

FG

2

1

3

7

Pin

5

4

8

9

6

Shell

5

7

8

External Device side
RJ45 (plug)

4

Pin Signal name

D0

NC

SG

D1

Display

Shield

Display side
D-sub 9 pin (socket)

DATA+

DATA-

NC

NC

Signal name

GND

NC

NC

NC

NC

FG

2

1

3

7

Pin

5

4

8

9

6

Shell

5

7

8

External Device side
RJ45 (plug)

4

Pin Signal name

D0

NC

SG

D1

Shield

5

7

8

External Device side
RJ45 (plug)

4

Pin Signal name

D0

NC

SG

D1
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5.16 Cable Diagram 16

16A)

Display
(Connection Port)

Cable Notes

GP3000 (COM1)
GP4000*1 (COM1)
GP6000 (COM1)
SP5000*2 (COM1/2)
SP-5B00 (COM1)
ST3000 (COM1)
ST6000 (COM1)
STM6000 (COM1)
STC6000 (COM1)
ET6000 (COM1)
LT3000 (COM1)
IPC*3

PC/AT

*1 All GP4000 models except GP-4100 series and GP-4203T

*2 Except SP-5B00

*3 Only the COM port which can communicate by RS-232C can be used.
 IPC COM Port (page 8)

16A

User-created cable

+
Cartridges TMC2SL1 or TMC2CONV01 

by Schneider Electric

The cable length must be 3m 
or less.

GP-4105  (COM1)
GP-4115T (COM1)
GP-4115T3 (COM1) 16B

User-created cable
+

Cartridges TMC2SL1 or TMC2CONV01 
by Schneider Electric

The cable length must be 3m 
or less.

LT-4*01TM (COM1)
LT-Rear Module (COM1) 16C

RJ45 RS-232C Cable (5m) by Pro-face
PFXZLMCBRJR21

+
Cartridges TMC2SL1 or TMC2CONV01 

by Schneider Electric

The cable length must be 3m 
or less.

Shield

2

7

8

5

4

3

Pin Signal name

Shell

6

Display side
D-sub 9 pin (socket)

External Device side
Terminal block

Signal name

TD(TXD)

GND

RD(RXD)

Display

SG

RD(RXD)

RS(RTS)

CS(CTS)

SD(TXD)

DR(DSR)

ER(DTR)

FG
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16B)

16C)

No. Name Notes

(1)
RJ45 RS-232C Cable (5m) by Pro-face

PFXZLMCBRJR21

• When using this connection, in the RS-232C communication settings set the 
[Flow Control] to [None].

Shield

Signal name

Shell

Display side
Terminal block

External Device side
Terminal block

Signal name

TD(TXD)

GND

RD(RXD)

Display

SG

RD(RXD)

RS(RTS)

CS(CTS)

SD(TXD)

DR(DSR)

ER(DTR)

External Device side
Terminal block

Signal name

TD(TXD)

GND

RD(RXD)
Display

GND

RXD

TXD

(1)
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5.17 Cable Diagram 17

Display
(Connection Port)

Cable Notes

GP3000*1 (COM1)
AGP-3302B (COM2)
GP-4*01TM (COM1)
GP-Rear Module 
(COM1)
ST3000*2 (COM2)
LT3000 (COM1)

17A

COM Port Conversion Adapter by Pro-face
CA3-ADPCOM-01

+
Terminal Block Conversion Adapter by Pro-face

CA3-ADPTRM-01
+

User-created cable
+

Cartridges TMC2SL1 or TMC2CONV01 
by Schneider Electric

The cable length 
must be 15m or 
less.

17B

User-created cable
+

Cartridges TMC2SL1 or TMC2CONV01 
by Schneider Electric

GP3000*3 (COM2)

17C

Online Adapter by Pro-face
CA4-ADPONL-01

+
Terminal Block Conversion Adapter by Pro-face

CA3-ADPTRM-01
+

User-created cable
+

Cartridges TMC2SL1 or TMC2CONV01 
by Schneider Electric

The cable length 
must be 15m or 
less.

17D

Online Adapter by Pro-face
CA4-ADPONL-01

+
User-created cable

+
Cartridges TMC2SL1 or TMC2CONV01 

by Schneider Electric

IPC*4

17E

COM Port Conversion Adapter by Pro-face
CA3-ADPCOM-01

+
Terminal Block Conversion Adapter by Pro-face

CA3-ADPTRM-01
+

User-created cable
+

Cartridges TMC2SL1 or TMC2CONV01 
by Schneider Electric

The cable length 
must be 15m or 
less.

17F

User-created cable
+

Cartridges TMC2SL1 or TMC2CONV01 
by Schneider Electric

GP-4106  (COM1)
GP-4116T (COM1) 17G

User-created cable
+

Cartridges TMC2SL1 or TMC2CONV01 
by Schneider Electric

The cable length 
must be 15m or 
less.
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GP-4107  (COM1)
GP-4*03T*5 (COM2)
GP-4203T (COM1) 17H

User-created cable
+

Cartridges TMC2SL1 or TMC2CONV01 
by Schneider Electric

The cable length 
must be 15m or 
less.

GP4000*6 (COM2)
GP-4201T (COM1)
GP6000 (COM2)
SP5000*7 (COM1/2)
SP-5B00 (COM2)
ST6000*8 (COM2)
ST-6200 (COM1)
STM6000 (COM1)
STC6000 (COM1)
ET6000*9 (COM2)
PS6000 (Basic Box) 
(COM1/2)

17I

RS-422 Terminal Block Conversion Adapter by Pro-face
PFXZCBADTM1

*10

+
User-created cable

+
Cartridges TMC2SL1 or TMC2CONV01 

by Schneider Electric

The cable length 
must be 15m or 
less.

17B

User-created cable
+

Cartridges TMC2SL1 or TMC2CONV01 
by Schneider Electric

LT-4*01TM (COM1)
LT-Rear Module 
(COM1) 17J

RJ45 RS-485 Cable (5m) by Pro-face
PFXZLMCBRJR81

+
Cartridges TMC2SL1 or TMC2CONV01 

by Schneider Electric

The cable length 
must be 15m or 
less.

PE-4000B*11

PS5000*11

PS6000 (Optional 
Interface)*11

17K

User-created cable
+

Cartridges TMC2SL1 or TMC2CONV01 
by Schneider Electric

The cable length 
must be 15m or 
less.

*1  All GP3000 models except AGP-3302B

*2 Except AST-3211A and AST-3302B

*3 All GP3000 models except GP-3200 series and AGP-3302B

*4 Only the COM port which can communicate by RS-422/485 (2 wire) can be used. (Except PE-4000B, PS5000,
and PS6000)
 IPC COM Port (page 8)

*5 Except GP-4203T

*6 All GP4000 models except GP-4100 series, GP-4*01TM, GP-Rear Module, GP-4201T and GP-4*03T

*7 Except SP-5B00

*8 Except ST-6200

*9 Due to the COM port specifications, flow control is not possible. Omit wiring the control pins on the Display
side of the cable diagram.

*10 When using a Terminal Block Conversion Adapter (CA3-ADPTRM-01) instead of the RS-422 Terminal Block
Conversion Adapter, refer to Cable Diagram 17A.

*11 Only the COM port which can communicate by RS-422/485 (2 wire) can be used.
 IPC COM Port (page 8)

Display
(Connection Port)

Cable Notes
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17A)
• 1:1 Connection

• 1:n Connection

Display

CA3-ADPTRM-01

CA3-ADPCOM-01

Shield

Display side
Terminal block

RDA

RDB

SDA

SDB

Signal name

SG

FG

TERMRX

User-created cable

External Device side
Terminal block

Signal name

D0

GND

D1 Termination 
resistance
120Ω 1/2W

Display

CA3-ADPTRM-01

CA3-ADPCOM-01

Shield

Display side
Terminal block

RDA

RDB

SDA

SDB

Signal name

SG

FG

TERMRX

User-created cable

External Device side
Terminal block

Signal name

D0

GND

D1

Shield

External Device side
Terminal block

Signal name

D0

GND

D1 Termination 
resistance
120Ω 1/2W
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17B)
• 1:1 Connection

• 1:n Connection

Display

Shield

Display side
D-sub 9 pin (socket)

RDA

RDB

SDA

SDB

Signal name

ERA

CSA

SG

1

2

3

7

Pin

4

8

5

CSB

ERB

6

FGShell

9

External Device side
Terminal block

Signal name

D0

GND

D1 Termination 
resistance
120Ω 1/2W

Display

Shield

Display side
D-sub 9 pin (socket)

RDA

RDB

SDA

SDB

Signal name

ERA

CSA

SG

1

2

3

7

Pin

4

8

5

CSB

ERB

6

FGShell

9

External Device side
Terminal block

Signal name

D0

GND

D1

Shield

External Device side
Terminal block

Signal name

D0

GND

D1 Termination 
resistance
120Ω 1/2W
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17C)
• 1:1 Connection

• 1:n Connection

Display

CA3-ADPTRM-01

CA4-ADPONL-01

Shield

Display side
Terminal block

RDA

RDB

SDA

SDB

Signal name

SG

FG

TERMRX

User-created cable

External Device side
Terminal block

Signal name

D0

GND

D1 Termination 
resistance
120Ω 1/2W

Display

CA3-ADPTRM-01

CA4-ADPONL-01

Shield

Display side
Terminal block

RDA

RDB

SDA

SDB

Signal name

SG

FG

TERMRX

User-created cable

External Device side
Terminal block

Signal name

D0

GND

D1

Shield

External Device side
Terminal block

Signal name

D0

GND

D1 Termination 
resistance
120Ω 1/2W
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17D)
• 1:1 Connection

• 1:n Connection

Shield

Display side
D-sub 9 pin (plug)

TERMRX

RDA

RDB

SDA

Signal name

TERMRX

SG

SDB

1

2

7

3

Pin

9

5

8

FGShell

External Device side
Terminal block

Signal name

D0

GND

D1 Termination 
resistance
120Ω 1/2W

Display

CA4-ADPONL-01

User-created cable

Shield

Display side
D-sub 9 pin (plug)

TERMRX

RDA

RDB

SDA

Signal name

TERMRX

SG

SDB

1

2

7

3

Pin

9

5

8

FGShell

Display

CA4-ADPONL-01

User-created cable

External Device side
Terminal block

Signal name

D0

GND

D1

Shield

External Device side
Terminal block

Signal name

D0

GND

D1 Termination 
resistance
120Ω 1/2W
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17E)
• 1:1 Connection

• 1:n Connection

Display

CA3-ADPTRM-01

CA3-ADPCOM-01

Shield

Display side
Terminal block

RDA

RDB

SDA

SDB

Signal name

SG

FG

TERMRX

User-created cable

External Device side
Terminal block

Signal name

D0

GND

D1 Termination 
resistance
120Ω 1/2W

Display

CA3-ADPTRM-01

CA3-ADPCOM-01

Shield

Display side
Terminal block

RDA

RDB

SDA

SDB

Signal name

SG

FG

TERMRX

User-created cable

External Device side
Terminal block

Signal name

D0

GND

D1

Shield

External Device side
Terminal block

Signal name

D0

GND

D1 Termination 
resistance
120Ω 1/2W
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17F)
• 1:1 Connection

• 1:n Connection

Display

Shield

Display side
D-sub 9 pin (socket)

DATA+

DATA-

NC

NC

Signal name

ERA

CSA

SG

1

2

3

7

Pin

4

8

5

CSB

ERB

6

FGShell

9

External Device side
Terminal block

Signal name

D0

GND

D1 Termination 
resistance
120Ω 1/2W

Display

Shield

Display side
D-sub 9 pin (socket)

DATA+

DATA-

NC

NC

Signal name

ERA

CSA

SG

1

2

3

7

Pin

4

8

5

CSB

ERB

6

FGShell

9

External Device side
Terminal block

Signal name

D0

GND

D1

Shield

External Device side
Terminal block

Signal name

D0

GND

D1 Termination 
resistance
120Ω 1/2W
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17G)
• 1:1 Connection

• 1:n Connection

*1 The resistance in the Display is used as the termination resistance. Set the value of the DIP Switch on the 
rear of the Display as shown in the table below.  

DIP Switch No. Set Value

1 OFF

2 OFF

3 OFF

4 OFF

Display

Shield

Display side
D-sub 9 pin (socket)

RDA

RDB

SDA

SDB

Signal name

ERA

CSA

SG

CSB

ERB

External Device side
Terminal block

Signal name

D0

GND

D1 Termination 
resistance
120Ω 1/2W

*1

Display

Shield

Display side
D-sub 9 pin (socket)

RDA

RDB

SDA

SDB

Signal name

ERA

CSA

SG

CSB

ERB

*1

External Device side
Terminal block

Signal name

D0

GND

D1

Shield

External Device side
Terminal block

Signal name

D0

GND

D1 Termination 
resistance
120Ω 1/2W



MODBUS SIO Master Driver

GP-Pro EX Device/PLC Connection Manual 181

17H)
• 1:1 Connection

• 1:n Connection

• The 5V output (Pin #6) on the Display is the power for the Siemens AG’s PROFIBUS 
connector. Do not use it for other devices.

• In COM on the GP-4107, the SG and FG terminals are isolated.

Display

Shield

Display side
D-sub 9 pin (socket)

LINE+

LINE-

NC

NC

Signal name

RS

5V

SG

3

8

1

2

Pin

4

6

5

NC

NC

9

FGShell

7

External Device side
Terminal block

Signal name

D0

GND

D1 Termination 
resistance
120Ω 1/2W

Display

Shield

Display side
D-sub 9 pin (socket)

LINE+

LINE-

NC

NC

Signal name

RS

5V

SG

3

8

1

2

Pin

4

6

5

NC

NC

9

FGShell

7

External Device side
Terminal block

Signal name

D0

GND

D1

Shield

External Device side
Terminal block

Signal name

D0

GND

D1 Termination 
resistance
120Ω 1/2W
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17I)
• 1:1 Connection

• 1:n Connection

Display

PFXZCBADTM1

Shield

Display side
Terminal block

RDA

RDB

SDA

SDB

Signal name

SG

FG

TERMRX

User-created cable

External Device side
Terminal block

Signal name

D0

GND

D1 Termination 
resistance
120Ω 1/2W

Display

PFXZCBADTM1

Shield

Display side
Terminal block

RDA

RDB

SDA

SDB

Signal name

SG

FG

TERMRX

User-created cable

External Device side
Terminal block

Signal name

D0

GND

D1

Shield

External Device side
Terminal block

Signal name

D0

GND

D1 Termination 
resistance
120Ω 1/2W
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17J)
• 1:1 Connection

• 1:n Connection

No. Name Notes

(1)
RJ45 RS-485 Cable (5m) by Pro-face

PFXZLMCBRJR81

External Device side
Terminal block

Signal name

D0

GND

D1 Termination 
resistance
120Ω 1/2W

Display

GND

D0

D1

(1)

Display

GND

D0

D1

(1)

External Device side
Terminal block

Signal name

D0

GND

D1

Shield

External Device side
Terminal block

Signal name

D0

GND

D1 Termination 
resistance
120Ω 1/2W
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17K)
• 1:1 Connection

• 1:n Connection

Display

Shield

Display side
D-sub 9 pin (socket)

DATA+

DATA-

NC

NC

Signal name

NC

NC

GND

2

1

3

7

Pin

4

8

5

NC

NC

6

FGShell

9

External Device side
Terminal block

Signal name

D0

GND

D1 Termination 
resistance
120Ω 1/2W

Display

Shield

Display side
D-sub 9 pin (socket)

DATA+

DATA-

NC

NC

Signal name

NC

NC

GND

2

1

3

7

Pin

4

8

5

NC

NC

6

FGShell

9

External Device side
Terminal block

Signal name

D0

GND

D1

Shield

External Device side
Terminal block

Signal name

D0

GND

D1 Termination 
resistance
120Ω 1/2W
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6 Supported Device

Range of supported device address is shown in the table below. Please note that the actually supported range of 

the devices varies depending on the External Device to be used. Please check the actual range in the manual of 

your External Device.

6.1 Micro/Premium/Twido/Quantum/Momentum/M221 Series

This address can be specified as system data area.

Device Bit Address Word Address
32
bits

Notes

Coil 000001 - 065536 000001 - 065521

or

*1

*1 High and low relationship of the stored data is specified by the [Double Word word order] setting of [Device
Setting].
"4.1 Setup Items in GP-Pro EX" (page 60)

 

Discrete Input 100001 - 165536 100001 - 165521  *2

*2 Write disabled

Input Register ----- 300001 - 365536  *2

Holding Register 400001,00 - 
465536,15*3

*3 An access method at the time of Bit Set varies depending on the [Rest of the bits in this word] setting of [Device
Setting].

- Clear................

- Do not clear..... 400001,00 - 465536,15

400001 - 465536  

• When the [Single Bit manipulation to Coil/Discrete Input] check box is selected in the [Individual 
Device Settings] dialog box, GP-Pro EX simulation does not synchronize the coil bit address and 
word address values.
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6.2 FCN/FCJ Series

This address can be specified as system data area.

6.3 Supported Function Code

Below is the list of Supported Function Code.

Device Bit Address Word Address
32
bits

Notes

Coil 000001 - 009984 000001 - 009969

or

*1

*1 High and low relationship of the stored data is specified by the [Double Word word order] setting of [Device
Setting].
"4.1 Setup Items in GP-Pro EX" (page 60)

 *2

*2 The device access range of the External Device is specified as 1 to 9999, that of the Display, however, as up to
9984, since the Display device is accessible in 16-bit units.

Discrete Input 100001 - 109984 100001 - 109969  *2 *3

*3 Write disabled

Input Register 300001.00 - 
309999.15 300001 - 309999  *3

Holding Register 400001.00 - 
409999.15 400001 - 409999  

• When the [Single Bit manipulation to Coil/Discrete Input] check box is selected in the [Individual 
Device Settings] dialog box, GP-Pro EX simulation does not synchronize the coil bit address and 
word address values.

Function Code (Hex) Description

FC01 (0x01) Reads the ON/OFF status of coils (0X references) in the slave.

FC02 (0x02) Reads the ON/OFF status of discrete inputs (1X references) in the slave.

FC03 (0x03) Reads the binary content of holding registers (4X references) in the slave.

FC04 (0x04) Reads the binary content of input registers (3X references) in the slave.

FC05 (0x05) Forces a single coil (0X references) to either ON or OFF

FC06 (0x06) Presets a value into a single holding register (4X references).

FC15 (0x0F) Forces each coil (0X references) in a sequence of coils to either ON or OFF.

FC16 (0x10) Presets values into a sequence of holding registers (4X references).

FC90(0x5A) Used when SoMachine Basic syntax is selected.

• FC15 / FC16 will be used for writing. In case if the connected controller do not support these 
function codes, then FC05 / FC06 will be used.
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6.4 IEC61131 address syntax

The following table gives the equivalences between the Modbus syntax and the IEC61131 syntax.

  

Device

Modbus address syntax IEC61131syntax

Format
0-based 1-based

Format Range
First 

element
Range

First 
element

Range
First

 element

Coil 000001+i i=0 to 
65535 000001 %Mi i=0 to 

65535 %M00000 i=1 to 
65536 %M00001

Discrete 
Input 100001+i i=0 to 

65535 100001 - - - - -

Input register
(word) 300001+i i=0 to 

65535 300001 - - - - -

Input register
(word bit) 300001+i,j

i=0 to 
65535
j=0 to15

300001,00 - - - - -

Holding 
register
(word)

400001+i i=0 to 
65535 400001 %MWi i=0 to 

65535 %MW00000 i=1 to 
65536 %MW00001

Holding 
register
(word bit)

400001+i,j
i=0 to 
65535
j=0 to15

400001,00 %MWi:
Xj

i=0 to 
65535
j=0 to 15

%MW00000:
X00

i=1 to 
65535
j=0  to15

%MW00001
:X00

• The two areas 100000 and 300000 are not accessible with the IEC syntax.
• Once you change the project which you have setup Discrete Input Register to IEC 61131 Syntax, 

the address will be undefined.
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6.5 SoMachine Basic syntax

SoMachine Basic syntax is available for M221 series only.

• TM221M16R/TM221ME16R/TM221M16T/TM221ME16T

Device Bit Address Word Address
32
bits

Notes

Memory bits %M00000 - %M01023 -----

or

*1

*1 High and low relationship of the stored data is specified by the [Double Word word order] setting of [Device
Setting].
"4.1 Setup Items in GP-Pro EX" (page 60)

Memory words %MW00000.00 - 
%MW07999.15

%MW00000 - 
%MW07999

*2 *3

*2 To use addresses %MD00000 - %MD07998 and %MF00000 - %MF07998 on the External Device, select
addresses %MW00000 - %MW07998. Then, set the [Data type] to either [32bit Dec]/[32bit Hex](%MD) or
[32bit Float](%MF).

Constant words %KW00000 - 
%KW00511.15

%KW00000 - 
%KW00511

*4 *5

Digital inputs
%I000.000 - %I000.007 ----- *5 *6

%I001.000 - %I014.031 ----- *5 *6 *7

Digital outputs

%Q000.000 - 
%Q000.007 ----- *6

%Q001.000 - 
%Q014.031 ----- *6 *7

Analog inputs

%IW000.000.00 - 
%IW000.001.15

%IW000.000 - 
%IW000.001

*5 *6

%IW001.000.00 - 
%IW014.007.15

%IW001.000 - 
%IW014.007

*5 *6 *7

Analog outputs %QW001.000.00 - 
%QW014.003.15

%QW001.000 - 
%QW014.003

*6 *7

System bits %S00000 - %S00159 -----

System words %SW00000.00 - 
%SW00233.15

%SW00000 - 
%SW00233

*3

Input channel status

%IWS000.000.00 - 
%IWS000.001.15

%IWS000.000 - 
%IWS000.001

*5 *6

%IWS001.000.00 - 
%IWS014.007.15

%IWS001.000 - 
%IWS014.007

*5 *6 *7

Output channel status %QWS001.000.00 - 
%QWS014.003.15

%QWS001.000 - 
%QWS014.003

*5 *6 *7
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*3 The access method for Bit Set varies depending on the [Rest of the bits in this word] setting in the [Individual
Device Setting] dialog box.

- Clear......................

- Do not clear........... When bits are written, the Display reads the corresponding word address from the External
Device, sets particular bits of that word address ON, and then returns the resulting word
address to the External Device. Note that the resulting data may not be correct if you write
to the word address from the External Device while the Display is reading from and writing
to the External Device.

*4 To use addresses %KD00000 - %KD00510 and %KF00000 - %KF00510 on the External Device, select
addresses %KW00000 - %KW00510. Then, set the [Data type] to either [32bit Dec]/[32bit Hex](%MD) or
[32bit Float](%MF).

*5 Write disabled

*6 The device address structure is as follows.
The module number is mapped to the attached unit.

*7 Available for use only when an I/O module is connected.

%Q xxx . yyy
Address (000 - 255)
Module No. (000 - 014)
Device

%IW xxx . yyy . zz
Bit address (00 - 15)
Address (000 - 255)
Module No. (000 - 014)
Device

Bit device Word device
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• TM221M32TK/TM221ME32TK

Device Bit Address Word Address
32
bits

Notes

Memory bits %M00000 - %M01023 -----

or

*1

*1 High and low relationship of the stored data is specified by the [Double Word word order] setting of [Device
Setting].
"4.1 Setup Items in GP-Pro EX" (page 60)

Memory words %MW00000.00 - 
%MW07999.15

%MW00000 - 
%MW07999

*2 *3

*2 To use addresses %MD00000 - %MD07998 and %MF00000 - %MF07998 on the External Device, select
addresses %MW00000 - %MW07998. Then, set the [Data type] to either [32bit Dec]/[32bit Hex](%MD) or
[32bit Float](%MF).

*3 The access method for Bit Set varies depending on the [Rest of the bits in this word] setting in the [Individual
Device Setting] dialog box.

- Clear......................

- Do not clear........... When bits are written, the Display reads the corresponding word address from the External
Device, sets particular bits of that word address ON, and then returns the resulting word
address to the External Device. Note that the resulting data may not be correct if you write
to the word address from the External Device while the Display is reading from and writing
to the External Device.

Constant words %KW00000 - 
%KW00511.15

%KW00000 - 
%KW00511

*4 *5

*4 To use addresses %KD00000 - %KD00510 and %KF00000 - %KF00510 on the External Device, select
addresses %KW00000 - %KW00510. Then, set the [Data type] to either [32bit Dec]/[32bit Hex](%MD) or
[32bit Float](%MF).

Digital inputs
%I000.000 - %I000.015 ----- *5 *6

%I001.000 - %I014.031 ----- *5 *6 *7

Digital outputs

%Q000.000 - 
%Q000.015 ----- *6

%Q001.000 - 
%Q014.031 ----- *6 *7

Analog inputs

%IW000.000.00 - 
%IW000.001.15

%IW000.000 - 
%IW000.001

*5 *6

%IW001.000.00 - 
%IW014.007.15

%IW001.000 - 
%IW014.007

*5 *6 *7

Analog outputs %QW001.000.00 - 
%QW014.003.15

%QW001.000 - 
%QW014.003

*6 *7

System bits %S00000 - %S00159 -----

System words %SW00000.00 - 
%SW00233.15

%SW00000 - 
%SW00233

*3

Input channel status

%IWS000.000.00 - 
%IWS000.001.15

%IWS000.000 - 
%IWS000.001

*5 *6

%IWS001.000.00 - 
%IWS014.007.15

%IWS001.000 - 
%IWS014.007

*5 *6 *7

Output channel status %QWS001.000.00 - 
%QWS014.003.15

%QWS001.000 - 
%QWS014.003

*5 *6 *7
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*5 Write disabled

*6 The device address structure is as follows.
The module number is mapped to the attached unit.

*7 Available for use only when an I/O module is connected.

%Q xxx . yyy
Address (000 - 255)
Module No. (000 - 014)
Device

%IW xxx . yyy . zz
Bit address (00 - 15)
Address (000 - 255)
Module No. (000 - 014)
Device

Bit device Word device



MODBUS SIO Master Driver

GP-Pro EX Device/PLC Connection Manual 192

• TM221C16/TM221CE16

Device Bit Address Word Address
32
bits

Notes

Memory bits %M00000 - %M01023 -----

or

*1

*1 High and low relationship of the stored data is specified by the [Double Word word order] setting of [Device
Setting].
"4.1 Setup Items in GP-Pro EX" (page 60)

Memory words %MW00000.00 - 
%MW07999.15

%MW00000 - 
%MW07999

*2 *3

*2 To use addresses %MD00000 - %MD07998 and %MF00000 - %MF07998 on the External Device, select
addresses %MW00000 - %MW07998. Then, set the [Data type] to either [32bit Dec]/[32bit Hex](%MD) or
[32bit Float](%MF).

Constant words %KW00000 - 
%KW00511.15

%KW00000 - 
%KW00511

*4 *5

Digital inputs
%I000.000 - %I000.008 ----- *5 *6

%I001.000 - %I014.031 ----- *5 *6 *7

Digital outputs

%Q000.000 - 
%Q000.006 ----- *6

%Q001.000 - 
%Q014.031 ----- *6 *7

Analog inputs

%IW000.000.00 - 
%IW000.001.15

%IW000.000 - 
%IW000.001

*5 *6

%IW001.000.00 - 
%IW014.007.15

%IW001.000 - 
%IW014.007

*5 *6 *7

%IW000.100.00 - 
%IW000.101.15

%IW000.100 - 
%IW000.101

*5 *6 *8

Analog outputs

%QW001.000.00 - 
%QW014.003.15

%QW001.000 - 
%QW014.003

*3 *6 *7

%QW000.100.00 - 
%QW000.101.15

%QW000.100 - 
%QW000.101

*3 *6 *9

System bits %S00000 - %S00159 -----

System words %SW00000.00 - 
%SW00233.15

%SW00000 - 
%SW00233

*3

Input channel status

%IWS000.000.00 - 
%IWS000.001.15

%IWS000.000 - 
%IWS000.001

*5 *6

%IWS001.000.00 - 
%IWS014.007.15

%IWS001.000 - 
%IWS014.007

*5 *6 *7

%IWS000.100.00 - 
%IWS000.101.15

%IWS000.100 - 
%IWS000.101

*5 *6 *8

Output channel status

%QWS001.000.00 - 
%QWS014.003.15

%QWS001.000 - 
%QWS014.003

*5 *6 *7

%QWS000.100.00 - 
%QWS000.101.15

%QWS000.100 - 
%QWS000.101

*5 *6 *9
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*3 The access method for Bit Set varies depending on the [Rest of the bits in this word] setting in the [Individual
Device Setting] dialog box.

- Clear......................

- Do not clear........... When bits are written, the Display reads the corresponding word address from the External
Device, sets particular bits of that word address ON, and then returns the resulting word
address to the External Device. Note that the resulting data may not be correct if you write
to the word address from the External Device while the Display is reading from and writing
to the External Device.

*4 To use addresses %KD00000 - %KD00510 and %KF00000 - %KF00510 on the External Device, select
addresses %KW00000 - %KW00510. Then, set the [Data type] to either [32bit Dec]/[32bit Hex](%MD) or
[32bit Float](%MF).

*5 Write disabled

*6 The device address structure is as follows.
The module number is mapped to the attached unit.

*7 Available for use only when an I/O module is connected.

*8 Available for use only when TMC2AI2, TMC2HOIS01, TMC2PACK01 or TMC2TI2 is connected.

*9 Available for use only when TMC2AQ2V or TMC2AQ2C is connected.

%Q xxx . yyy
Address (000 - 255)
Module No. (000 - 014)
Device

%IW xxx . yyy . zz
Bit address (00 - 15)
Address (000 - 255)
Module No. (000 - 014)
Device

Bit device Word device
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• TM221C24/TM221CE24

Device Bit Address Word Address
32
bits

Notes

Memory bits %M00000 - %M01023 -----

or

*1

*1 High and low relationship of the stored data is specified by the [Double Word word order] setting of [Device
Setting].
"4.1 Setup Items in GP-Pro EX" (page 60)

Memory words %MW00000.00 - 
%MW07999.15

%MW00000 - 
%MW07999

*2 *3

*2 To use addresses %MD00000 - %MD07998 and %MF00000 - %MF07998 on the External Device, select
addresses %MW00000 - %MW07998. Then, set the [Data type] to either [32bit Dec]/[32bit Hex](%MD) or
[32bit Float](%MF).

Constant words %KW00000 - 
%KW00511.15

%KW00000 - 
%KW00511

*4 *5

Digital inputs
%I000.000 - %I000.013 ----- *5 *6

%I001.000 - %I014.031 ----- *5 *6 *7

Digital outputs

%Q000.000 - 
%Q000.009 ----- *6

%Q001.000 - 
%Q014.031 ----- *6 *7

Analog inputs

%IW000.000.00 - 
%IW000.001.15

%IW000.000 - 
%IW000.001

*5 *6

%IW001.000.00 - 
%IW014.007.15

%IW001.000 - 
%IW014.007

*5 *6 *7

%IW000.100.00 - 
%IW000.101.15

%IW000.100 - 
%IW000.101

*5 *6 *8

Analog outputs

%QW001.000.00 - 
%QW014.003.15

%QW001.000 - 
%QW014.003

*3 *6 *7

%QW000.100.00 - 
%QW000.101.15

%QW000.100 - 
%QW000.101

*3 *6 *9

System bits %S00000 - %S00159 -----

System words %SW00000.00 - 
%SW00233.15

%SW00000 - 
%SW00233

*3

Input channel status

%IWS000.000.00 - 
%IWS000.001.15

%IWS000.000 - 
%IWS000.001

*5*6

%IWS001.000.00 - 
%IWS014.007.15

%IWS001.000 - 
%IWS014.007

*5 *6 *7

%IWS000.100.00 - 
%IWS000.101.15

%IWS000.100 - 
%IWS000.101

*5 *6 *8

Output channel status

%QWS001.000.00 - 
%QWS014.003.15

%QWS001.000 - 
%QWS014.003

*5 *6 *7

%QWS000.100.00 - 
%QWS000.101.15

%QWS000.100 - 
%QWS000.101

*5 *6 *9
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*3 The access method for Bit Set varies depending on the [Rest of the bits in this word] setting in the [Individual
Device Setting] dialog box.

- Clear......................

- Do not clear........... When bits are written, the Display reads the corresponding word address from the External
Device, sets particular bits of that word address ON, and then returns the resulting word
address to the External Device. Note that the resulting data may not be correct if you write
to the word address from the External Device while the Display is reading from and writing
to the External Device.

*4 To use addresses %KD00000 - %KD00510 and %KF00000 - %KF00510 on the External Device, select
addresses %KW00000 - %KW00510. Then, set the [Data type] to either [32bit Dec]/[32bit Hex](%MD) or
[32bit Float](%MF).

*5 Write disabled

*6 The device address structure is as follows.
The module number is mapped to the attached unit.

*7 Available for use only when an I/O module is connected.

*8 Available for use only when TMC2AI2, TMC2HOIS01, TMC2PACK01 or TMC2TI2 is connected.

*9 Available for use only when TMC2AQ2V or TMC2AQ2C is connected.

%Q xxx . yyy
Address (000 - 255)
Module No. (000 - 014)
Device

%IW xxx . yyy . zz
Bit address (00 - 15)
Address (000 - 255)
Module No. (000 - 014)
Device

Bit device Word device
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• TM221C40/TM221CE40

Device Bit Address Word Address
32
bits

Notes

Memory bits %M00000 - %M01023 -----

or

*1

Memory words %MW00000.00 - 
%MW07999.15

%MW00000 - 
%MW07999

*2 *3

Constant words %KW00000 - 
%KW00511.15

%KW00000 - 
%KW00511

*4 *5

Digital inputs
%I000.000 - %I000.023 ----- *5 *6

%I001.000 - %I014.031 ----- *5 *6 *7

Digital outputs

%Q000.000 - 
%Q000.015 ----- *6

%Q001.000 - 
%Q014.031 ----- *6 *7

Analog inputs

%IW000.000.00 - 
%IW000.001.15

%IW000.000 - 
%IW000.001

*5 *6

%IW001.000.00 - 
%IW014.007.15

%IW001.000 - 
%IW014.007

*5 *6 *7

%IW000.100.00 - 
%IW000.101.15

%IW000.200.00 - 
%IW000.201.15

%IW000.100 - 
%IW000.101

%IW000.200 - 
%IW000.201

*5 *6 *8

Analog outputs

%QW001.000.00 - 
%QW014.003.15

%QW001.000 - 
%QW014.003

*3 *6 *7

%QW000.100.00 - 
%QW000.101.15

%QW000.200.00 - 
%QW000.201.15

%QW000.100 - 
%QW000.101

%QW000.200 - 
%QW000.201

*3 *6 *9

System bits %S00000 - %S00159 -----

System words %SW00000.00 - 
%SW00233.15

%SW00000 - 
%SW00233

*3

Input channel status

%IWS000.000.00 - 
%IWS000.001.15

%IWS000.000 - 
%IWS000.001

*5 *6

%IWS001.000.00 - 
%IWS014.007.15

%IWS001.000 - 
%IWS014.007

*5 *6 *7

%IWS000.100.00 - 
%IWS000.101.15

%IWS000.200.00 - 
%IWS000.201.15

%IWS000.100 - 
%IWS000.101

%IWS000.200 - 
%IWS000.201

*5 *6 *8

Output channel status

%QWS001.000.00 - 
%QWS014.003.15

%QWS001.000 - 
%QWS014.003

*5 *6 *7

%QWS000.100.00 - 
%QWS000.101.15

%QWS000.200.00 - 
%QWS000.201.15

%QWS000.100 - 
%QWS000.101

%QWS000.200 - 
%QWS000.201

*5 *6 *9



MODBUS SIO Master Driver

GP-Pro EX Device/PLC Connection Manual 197

*1 High and low relationship of the stored data is specified by the [Double Word word order] setting of [Device
Setting].
"4.1 Setup Items in GP-Pro EX" (page 60)

*2 To use addresses %MD00000 - %MD07998 and %MF00000 - %MF07998 on the External Device, select
addresses %MW00000 - %MW07998. Then, set the [Data type] to either [32bit Dec]/[32bit Hex](%MD) or
[32bit Float](%MF).

*3 The access method for Bit Set varies depending on the [Rest of the bits in this word] setting in the [Individual
Device Setting] dialog box.

- Clear......................

- Do not clear........... When bits are written, the Display reads the corresponding word address from the External
Device, sets particular bits of that word address ON, and then returns the resulting word
address to the External Device. Note that the resulting data may not be correct if you write
to the word address from the External Device while the Display is reading from and writing
to the External Device.

*4 To use addresses %KD00000 - %KD00510 and %KF00000 - %KF00510 on the External Device, select
addresses %KW00000 - %KW00510. Then, set the [Data type] to either [32bit Dec]/[32bit Hex](%MD) or
[32bit Float](%MF).

*5 Write disabled

*6 The device address structure is as follows.
The module number is mapped to the attached unit.

*7 Available for use only when an I/O module is connected.

*8 Available for use only when TMC2AI2, TMC2HOIS01, TMC2PACK01 or TMC2TI2 is connected.

*9 Available for use only when TMC2AQ2V or TMC2AQ2C is connected.

• Please refer to the GP-Pro EX Reference Manual for system data area.
Cf. GP-Pro EX Reference Manual "LS Area (Direct Access Method Area)"

• Please refer to the precautions on manual notation for icons in the table.

"Manual Symbols and Terminology"

%Q xxx . yyy
Address (000 - 255)
Module No. (000 - 014)
Device

%IW xxx . yyy . zz
Bit address (00 - 15)
Address (000 - 255)
Module No. (000 - 014)
Device

Bit device Word device
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7 Device Code and Address Code

Use device code and address code when you select "Device Type & Address" for the address type in data displays.

7.1 Micro/Premium/Twido/Quantum/Momentum/M221 Series

7.2 FCN/FCJ Series

7.3 SoMachine Basic Syntax

Device Device Name
Device Code

(HEX)
Address Code

Coil 0 0080 Value of (word address - 1) divided by 16

Discrete Input 1 0081 Value of (word address - 1) divided by 16

Input Register 3 0001 Value of word address from which 1 is 
deducted

Holding Register 4 0000 Value of word address from which 1 is 
deducted

Device Device Name
Device Code

(HEX)
Address Code

Coil 0 0080 Value of (word address - 1) divided by 16

Discrete Input 1 0081 Value of (word address - 1) divided by 16

Input Register 3 0001 Value of word address from which 1 is 
deducted

Holding Register 4 0000 Value of word address from which 1 is 
deducted

Device Device Name
Device Code

(HEX)
Address Code

Memory words %MW 0000 Value of word address

Constant words %KW 0002 Value of word address

Analog inputs %IW 0008 Value of word address

Analog outputs %QW 0009 Value of word address

System words %SW 0004 Value of word address

Input channel status %IWS 000A Value of word address

Output channel status %QWS 000B Value of word address
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8 Error Messages

Error messages are displayed on the screen of Display as follows: "No. : Device Name: Error Message (Error 

Occurrence Area)". Each description is shown below.

Display Examples of Error Messages

"RHAA035: PLC1: Error has been responded for device write command (Error Code: 2 [02H])"

Item Description

No. Error No.

Device Name Name of External Device where error occurs. Device name is a title of External Device set 
with GP-Pro EX. (Initial value [PLC1])

Error Message Displays messages related to the error which occurs.

Error Occurrence Area

Displays IP address or device address of External Device where error occurs, or error codes 
received from External Device.

• IP address is displayed such as "IP address(Decimal): MAC address( Hex)".
• Device address is displayed such as "Address: Device address".
• Received error codes are displayed such as "Decimal[Hex]".

• Refer to your External Device manual for details on received error codes.
• Refer to "Display-related errors" in "Maintenance/Troubleshooting Guide" for details on the error 

messages common to the driver.
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